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à Getting Started

You can begin using PageKeeper as soon as you finish installation. You can also customize some 
PageKeeper behaviors to suit your preferences and increase your efficiency.

This topics describe:

¨ Getting Started--Quick Start
¨ Starting PageKeeper
¨ Exiting PageKeeper
¨ PageKeeper Windows
¨ Using Menus
¨ Setting up the Transaction File



à Building a Database

PageKeeper lets you store different types of documents from many sources in a single database. It also 
provides ready access to information elsewhere on your system through indexes you create. You can 
import text and image files from your hard disk and directories and you can scan in hardcopy documents 
directly. PageKeepers page-recognition technology preserves scanned images and makes the text 
computer-usable.

PageKeeper automatically indexes the information as it is added to the database. You can create 
multiple databases to organize different types of information. You can also create indexes for external 
files.

The following topics describe:

¨ Building a Database--Quick Start
¨ Creating a New Database
¨ Opening an Existing Database
¨ Adding to the Database
¨ Organizing the Database
¨ PageKeeper Indexes
¨ Maintaining the System



à Searching Made Relevant

PageKeeper presents the documents that satisfy your search request in order of relevance and 
graphically displays the closeness of the match to your query with a colored relevance bar for each 
document in the list.

The following topics describe:

¨ Relevance is Graphically Displayed
¨ Searching Made Relevant--Quick Start
¨ How Weighted Relevance Retrieval Works
¨ What Gets Searched
¨ Selecting a Search Method
¨ Using the Weighted Word Search
¨ Using the Weighted Boolean Search
¨ Using the Document Agent Search
¨ Saving Search Results



à Network Sharing and Mailing

PageKeeper is designed for collaborative workgroup computing and efficient workflow. Its searching 
capabilities eliminate the need to figure out someone elses filing system. Every user of the database 
has access to the same information, but each user can organize it independently in a separate folder 
without extra disk space consumption.

And with PageKeepers annotation and e-mail features, you can add meaning to the information in the 
database and expand your knowledge pool.

As a workgroup, youll want to establish policies for certain database functions, such as indexing and 
deleting documents.

The following topics describe:

¨ Network Sharing and Mailing--Quick Start
¨ User Access
¨ Using Mail
¨ Sharing a Database
¨ Database Security
¨ Scanning and Indexing Simultaneously
¨ Sharing the Indexes



à Using and Sharing Information

PageKeeper is designed for the way you use and exchange information. It provides a number of ways 
for you to add and extract value from the documents in your database. For example, you can copy text 
or graphics from a document into other applications, export documents in different formats, add notes, 
send copies to other users, and print documents in text and image view. 

These topics describe:

¨ Using and Sharing Information--Quick Start
¨ Opening and Viewing Database Documents
¨ Copying Information from Documents
¨ Adding Notes
¨ Printing
¨ Exporting Documents



à Customizing Your Tools

You can design a desktop that gives you quick and easy access to the functions you use most often. 
You can decide which windows open first when you start PageKeeper, what the button box looks like, 
which commands are in the button box, and how the windows behave.

Customizing is so simple that you can change your options when you are concentrating on a particular 
task and then quickly return to your standard setup.

These topics describe: 

¨ Customizing Your Tools--Quick Start
¨ Adding Commands to the Button Box
¨ Changing the Size of the Button Box
¨ Changing the Document Text
¨ Changing the Initial Windows Display
¨ Menu Options



à Document Processing Options

You can decide how and when you want to add documents to the PageKeeper database. You can 
choose whether or not you want to edit files before they are added to the database, whether or not you 
want to select certain zones for page recognition and when you want to perform those interactive 
processes. You can also choose automatic importing or recognition and save the indexing and/or 
recognition until later to make best use of your computer resources.

The following topics describe:

¨ Scanning -- Quick Start
¨ Importing an Image -- Quick Start
¨ Importing a Text File -- Quick Start
¨ Specifying Settings
¨ Using Recognition Tools
¨ Using the Editing Tools



à Scanners

Once a scanner is installed and working with its image scanning software, most users can install and 
use PageKeeper with no other changes to their system.

To get up and running as quickly as possible, install your scanner hardware and any software you 
received with your scanner according to the manufacturer's instructions. Use the scanning software 
supplied by the manufacturer to be sure the scanner is working on your system before scanning with 
PageKeeper. Consult your scanner documentation or your scanner's manufacturer if your scanner does 
not work with the manufacturer-supplied scanning software. Resolve any problems before continuing.

¨ Supported Scanners



à Troubleshooting

Although PageKeeper is designed to be easy to use, problems sometimes occur. The following topics 
explain solutions to some of the common problems you may encounter and tells you how to improve 
performance. It is divided into the following sections:

· Before You Begin Troubleshooting ¾ You can take several steps to check your system's 
operation. 

· Installation and Setup Problems ¾ You are unable to complete the PageKeeper installation and 
set up the system.

· Transaction File Problems ¾ You are unable to open or create a database.

· Scanning Problems ¾ You are unable to scan a text or image document. Or you are having 
performance problems with the speed or quality of scanned documents.

· Performance Problems ¾ You were able to install and set up PageKeeper, but certain features do 
not work, performance is poor, or your system quits unexpectedly.

· Error Recovery ¾ You have received an error message from PageKeeper.

· Contacting Technical Support ¾ You are unable to resolve a problem, or you need additional 
technical information.



à Error Recovery

¨ Error Messages A - E
¨ Error Messages F - M
¨ Error Messages N - N
¨ Error Messages O - O
¨ Error Messages Pa - Pa
¨ Error Messages Pl - Pz
¨ Error Messages R - S
¨ Error Messages T - T
¨ Error Messages U - Z



D Index
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Adding a new button to the button box
Adding Commands to the button box
Adding Notes
Adding to the Database
Adjust
Admin Menu
Arrange Icons
Auto Spelling
Auto Spelling Assist
Auto-Open/Folders
Auto-Open/Mail Box
Auto-Open/Post Office

B

Batching Scanning and Indexing
Beep for New Mail
Before You Begin Troubleshooting
Blank Separators
Browse Documents
Browse Notes
Building a Database
Building a Database--Quick Start
Button Box/Hidden
Button Box/Narrow
Button Box/Wide

C

Cascade
Changing the Document Text
Changing the Image Size
Changing the Initial Windows Display
Changing the Transaction File
Changing the Size of the Button Box
Close Active Window
Close All
Close Database
Collapse All
Collapse Branch
Copy
Copying an Image
Copying Folders
Copying Information from Documents
Copying Text
Create Folder...
Create Note
Create Results Folder
Creating a New Database
Creating Notes



Customizing Your Tools
Customizing Your Tools--Quick Start
Cut

D

Database Security
Delete
Delete Folders
Delete Mail
Delete Note
Delete Users...
Document Agent Search - How to
Document Agent Search...Command
Document Agenting
Document Exporting
Document Menu
Document Processing Options
Double Sided pages
Draw Zones

E

Edit Menu
Edit Name...
Editing Tools
Erase Zones
Error Messages A - E
Error Messages F - M
Error Messages N - N
Error Messages O - O
Error Messages Pa - Pa
Error Messages Pl - Pz
Error Messages R - S
Error Messages T - T
Error Messages U - Z
Evaluating Brightness Settings
Exit
Exiting PageKeeper
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Expand Branch
Expand/Collapse
Export to File...
Exporting a File
Exporting Documents

F

File Exporting
File Menu
Find after Replace
Find Backwards
Find Next
Find Previous
Finish Unattended OCR/Indexing
First Page
Folders Menu
Getting Started



Go to Page...
Go to Search Word

H

Help Menu
How Hyphenations Are Handled
How Weighted Relevance Retrieval Works
Hyphenations

I

Image Size
Image View
Import from File...
Importing a Group of Files
Importing a Text File
Importing a Text File -- Quick Start
Importing an Image -- Quick Start
Indexes
Indexing Hard Drive or Network Files

K

Keyboard Shortcuts

L

Last Page
Locate File Index...

M

Mail
Mail Menu
Maintaining the System
Make Agent Document
Match Case
Menu Options
Menus - Using
Move...
Moving Between Pages
Multiple Pages

N

Network Sharing and Mailing
Network Sharing and Mailing--Quick Start
New Database...
Next Page
Noise Words
Notes
Notes Are Indexed
Notes Menu

O

One Search at a Time
Open Database...
Open Document
Opening an Existing Database



Opening and Deleting Notes
Opening and Viewing Database Documents
Options Dialog Box
Options Menu
Order Zones
Organizing the Database
Orientation

P

Page Layout...
Paste
Previous Agent Document
Previous Page
Previous Search Word
Print Setup...
Print...
Printing
Printing Annotations
Printing Images
Procedures

Q

Quick Scan

R

(Re-)Index Files...
Re-Index Database
Read Message Text...
Reading Mail
Recognition Tools
Recognize
Recognize/Edit Scanned Docs...
Recondition Database
Reconditioning the Database
Reject Character
Relevance is Graphically Displayed
Results Folder
Results Menu
Rotation arrows

S

Save Note
Saving Search Results
Scan Setup...
Scan...
Scanners
Scanning -- Quick Start
Scanning and Indexing Simultaneously
Scanning Documents into the Database
Scanning Options
Search Menu
Searching Made Relevant
Searching Made Relevant--Quick Start
Searching with Hyphenations
Selecting a Search Method



Selection Tool
Sending Mail
Setting up the Transaction File
Sharing a Database
Sharing Information
Sharing the Indexes
Show Folders/Hide Folders
Show Mail Box/Hide Mail Box
Show Post Office/Hide Post Office
Single Page
Sort by Name
Sort by Relevance
Specifying Settings
Starting PageKeeper
Stepping Through the Search Words
Supported File Formats
Supported Scanners

T

Task Buttons
Text View
Text View Colors/System Colors
Text View Colors/White on Blue
Tile
Tools - Editing
Tools - Recognition
Transaction File
Troubleshooting

U

Updating External File Indexes
User Access
User Name Box
Using and Sharing Information
Using and Sharing Information--Quick Start
Using Mail
Using Menus
Using the Editing Tools

W

Weighted Boolean Search - How to
Weighted Boolean Search... Command
Weighted Boolean Searching
Weighted Word Search - How to
Weighted Word Search... Command
Weighted Word Searching
What Gets Searched
Whole Word
Window Colors in Text View
Window Menu
Windows
Working with External Files
Wrap Around

X



Y
Z

Zoom Out/Zoom In
Zoom Tools



D Keyboard Shortcuts

File Menu

Create a new database...... Ctrl + N

Open a database........... Ctrl + O

Open a document........... (Select) then Enter

Close the active window...... Ctrl + F4

Print the current document... Ctrl+ P

Save editing changes........ Ctrl + S

Exit PageKeeper............. Alt + F4

Edit Menu

Cut the current selection to the 
clipboard.................. Ctrl + X

Copy the current selection to the 
clipboard............... Ctrl + C

Paste the clipboard contents at 
the cursor location......... Ctrl + V

Delete the current selection... Del

Style Menu

Format text as bold........... Ctrl + B

Format text as italic.......... Ctrl + I

Format text with an underline.. Ctrl + U

Document Menu

Find the location of the next 
search word ............... Tab

Find the location of the previous 
search word 
................

Shift + Tab

Folders Menu

Expand or collapse the next level 
of folders and 
documents.........

Space

Selecting documents

To select a contiguous group of 
documents................ Highlight the first document you 

want, press the Shift key, and then 



click the last document that you 
want. 

To select multiple documents
that are not adjacent......... Ctrl-click each icon.

D Noise Words

Noise words are words that are so common in the English language that searching for them is generally 
not meaningful. PageKeeper eliminates these common noise words from the indexes it creates.

After you have saved your changes, re-index your database or databases to have the changes take 
effect. The words that you have added to the file stopword.lst will no longer appear in a Weighted Word 
Search or a Weighted Boolean Search. Document Agent searching, however, is not affected by changes 
to this list.

Related Topics

Words Not Searched
Changing the Noise Words



D Words Not Searched

You'll notice that the following list contains many helping verbs, prepositions, articles and other words 
that are so common that you will not want to search for them:

a by I out thought
about could if over through
after couldn't in same thus
again did into shall to
all didn't is shan't too
along do isn't she up
also does it should us
always doesn't many shouldn't very
am don't me so was
an done might some we
and down more something were
another each most still what
any every much such when
are few must than where
around for my that which
as from no the while
at gets not their who
away had of them why
be has off then with
because hasn't often there would
been have on these wouldn't
before he one they you
below her only thing your
between him or things
both his other this
but how our those

D Changing the Noise Words

You can add additional words to the list of noise words or delete words from the list if you find it 
necessary. 

The list is located in the file called stopword.lst and will be located in the same directory as your 
pagekeep.exe file. Be sure to make a backup copy of the original file before you start modifying this list.

After you have saved your changes, re-index your database or databases to have the changes take 
effect. 

PageKeeper refers to the stopword.lst during the creation of the database and when the files are re-
indexed. So, it is possible for advanced users to create and use a special stopword.lst for a specific 
database.



D Procedures

Use this alphabetical list to find step-by-step instructions for PageKeeper tasks.

A

Adding a new button to the button box
Auto Spelling

B

Before You Begin Troubleshooting
Building a Database--Quick Start

C

Changing the Image Size
Changing the Transaction File
Copying an Image
Copying Text
Creating a New Database
Creating Notes
Customizing Your Tools--Quick Start

D
, 
E

Evaluating Brightness Settings
Exporting a File

F, 
H
, 
I

Importing a Group of Files
Importing a Text File -- Quick Start
Importing a Text File
Importing an Image -- Quick Start
Indexing Hard Disk or Network Files

K, 
L, 
M

Make Agent Document

N

Network Sharing and Mailing--Quick Start

O

Opening an Existing Database

P



Printing

Q
,
R
 

Reading Mail

S

Saving Search Results
Scanning -- Quick Start
Scanning a new document into the database
Searching Made Relevant--Quick Start
Sending Mail
Starting PageKeeper

T
,
 
U
    

Updating External File Indexes
Using and Sharing Information--Quick Start
Using Menus
Using the Document Agent Search
Using the Weighted Boolean Search
Using the Weighted Word Search

W,X,
Y,Z



D Task Buttons

The buttons in the default button box perform the following tasks:

Weighted Word 
Search ¾ searches 
for a word or words 
and returns 
documents in order 
of relevance to your 
query.

Show 
Folders/Hide 
Folders ¾ 
changes the 
current display of 
the Folders 
window

Scan... ¾ scans 
documents into 
the database 
according to the 
options you 
specify.

Show Mail 
Box/Hide Mail Box 
¾ changes the 
current display of 
the Mail Box 
window.

 Delete... ¾ deletes the current selection.

 Print... ¾ prints the currently selected or displayed document and notes.

 Text view ¾ displays the document text.

 Image View ¾ displays the original scanned version of the file (if available).

 Previous Page ¾ displays the previous sequential page of the document.

 Next Page ¾ displays the next sequential page of the document.

 Zoom-In Tool ¾ selects and deselects a tool for enlarging the bitmap image of a document.

 Zoom-Out Tool ¾ selects and deselects a tool for reducing the bitmap image of a document.



 Document Agent Search ¾ uses analysis of a document's content to find other documents with similar 
content and displays a content tree and a relevance list of the results.

 Show Post Office/Hide Post Office ¾ changes the current display of the Post Office window. (Open this 
window to send files to other users.)



Ñ Getting StartedQuick Start

To set up PageKeeper:

1. Make sure that you have the correct hardware, software, and amount of memory specified in the 
system requirements.

2. Copy the installation disks.

3. Insert the PageKeeper disk labeled Disk 1, go to the appropriate drive (e.g. b:), type setup at the 
prompt, and follow the installation instructions.

4. Complete the online warranty registration form and mail it in the business reply envelope 
provided.

5. Remove the disk, start Windows, and double-click the PageKeeper icon to start the application.

6. Create or open a database.

To create a new database, select the Create New button and enter the name and directory path 
of your new database in the dialog box that opens. Click OK. You are automatically logged in as 
Admin.

To open an existing database, select the Open Other button and enter the name and directory 
path of your database in the dialog box that opens. Click OK. Type your name into the User 
Name box of the User Login window and click OK.

When the database opens, PageKeeper is ready to store and retrieve information.

Related Topics

Starting PageKeeper

Exiting PageKeeper

PageKeeper Windows

Using Menus



Ñ Starting PageKeeper

To start PageKeeper for the first time:

1. Start Windows and open the Caere Applications program group.

2. Double-click the PageKeeper icon.

PageKeeper opens with the message No database is open in the title bar and a Database Login 
dialog box in the middle of the window. If you installed the sample database, it is listed as the 
default database. 

3. Choose Create New or Open Other to create or open a database. 

Select Create New to create a new database. A New Database dialog box opens to let you select 
the location for the new database (the working directory for PAGEKEEPER is the default directory 
path). Name the new database with the .pkp extension.

Select Open Other to locate an existing database. An Open Database dialog box lets you select 
the path of an existing database and open it.

4. Login by selecting OK in the dialog box that opens or by typing your name into the User Name 
box and then clicking OK. 

If you selected a name and path for a new database, a dialog box opens that says When the new 
database is created, you will be logged in as Admin. Click OK in this box. As the database Admin 
user you will have full access to the commands in the Admin menu for indexing network 
directories, and re-indexing and maintaining the database. 

If you selected the name and path of an existing database, you can type your name into the User 
Name box of the User Login dialog box.

5. The name of the database you created or opened appears in the PageKeeper title bar.

You can begin adding information to the database and indexing and searching information on 
your local and network drives.

Related Topics

Adding to the Database

Creating a New Database

Exiting PageKeeper

Opening an Existing Database

PageKeeper Windows

Using Menus



Ñ Exiting PageKeeper

To maintain the integrity of your database, you should follow standard Windows procedure for exiting 
PageKeeper. Exit PageKeeper and quit Windows from the Program Manager before turning off your 
computer. If you must reboot your machine for some reason, use Ctrl+Alt+Delete whenever possible 
instead of doing a hard reset or powering off the computer. 



Ñ PageKeeper Windows

PageKeeper's unique interface includes six different windows:

¨ Document Viewing Window

¨ Search results window

¨ Folders window

¨ Note window

¨ Mailbox window

¨ Post Office window

The windows are independent and yet the presence of one will affect the way another will open for 
viewing. 

A change to a document in one window will affect that document in another window. For example, if you 
have a document open for viewing and you change its name in the folders window, the name change 
appears in the viewing window and any other window where the document appears.

The third item from the left in the PageKeeper menu bar changes according to which window is open:

· The Documents menu item appears when a document window is active.

· The Results menu item appears when a search results window is active.

· The Folders menu item appears when the folders window is active.

· The Notes menu item appears when a note window is active.

· The Mail menu item appears when the Mailbox window or the Post Office window is active.

Related Topics

Opening an Existing Database

Using Menus



Ñ Using Menus

You can choose PageKeeper commands from the menus or from the button box.

PageKeeper menus function like other menus on the Windows desktop. You have these choices for 
selecting a menu option:

· Use the mouse to pull down the menu and highlight the option you want to select.

· Hold down the Alt key while you type the underlined letter in the menu name to select the menu, 
then type the underlined letter in the menu option. For example, you can press Alt+F to open the 
File menu and then press N to execute the New Database... option.

· Use the shortcut key, if available. Shortcut keys are listed to the right of the menu option name. 
For example, you can press Ctrl+N to go directly to the dialog box for the New Database... option.

There are standard Windows keyboard equivalents for most PageKeeper functions. For example, 
instead of clicking OK, you can press the Enter key to exit most dialog boxes. See your Windows user's 
guide for more information.

Related Topics

Keyboard Shortcuts

PageKeeper Windows



Ñ Setting Up the Transaction File

PageKeeper uses the transaction file to help ensure the integrity of your data, so it is vital that you set it 
up correctly. The first consideration in determining the location of this file is whether you are going to 
share PageKeeper databases with other users on your network.

The most important criterion for the location of the PageKeeper transaction file is that all users sharing 
PageKeeper databases use the same transaction file. For this reason we recommend that the network 
administrator establish the transaction file path for all network installations. See Appendix C    Setup 
Specifics in the PageKeeper Owner's Manual for additional information.

You can call the transaction file anything you want. The default filename for the transaction file is 
pagekeep.trn. 

Single Users

If you are running PageKeeper as a single-user, you can use c:\pagekeep.trn for the location of the 
transaction file. If, however, you are locating a database on the network, you should locate the 
transaction file on the network as well since it is used for data recovery.

Workgroups

For PageKeeper workgroups on a network there are two very important requirements for the location of 
this file:

· You and all other PageKeeper users of the workgroup must be able to read from and write to the 
file location.

· All users of a workgroup installation must be using the same transaction file. They do not have to 
have the same drive mapping to that file, but they must be using the same physical file. Although 
it is possible for users to access the same network database while referencing different network 
transaction files, this can result in lost data and loss of data integrity.

The format for the transaction file path is:

drive:\optional-directory-name\filename

Related Topics

Changing the Transaction File  ChangingtheTransactionFile  

Using and Sharing Information



Ñ Changing the Transaction File

Before you change the way you share PageKeeper data, it is very important that you check the location 
of the PageKeeper transaction file. As described above, everyone using PageKeeper as a workgroup 
application must have read and write access to the same transaction file.

If you need to change the location of the transaction file after installing PageKeeper, you can locate it in 
your Windows pagekeep.ini file. 

To change your transaction file:

1. Open your Windows pagekeep.ini file.

2. Search for the term PageKeeper Options. 

You should see two lines that look like this:

[PageKeeper Options]

Transaction File=drive:\optional-directory-name\filename

The path and filename of the transaction file will be those you set during installation (or the last time it 
was changed).

3. Change the path to meet the needs of your site. For example, if you are a single-system user, 
your transaction file setting might look like this:

[PAGEKEEPER Options]

Transaction File=C:\PAGEKEEP.TRN

If you are running PageKeeper on a network, your transaction file path might look like this:

Transaction File=G:\SHARED\PAGEKEEP.TRN



D Building a DatabaseQuick Start

To add information to a new or existing database:

1. Create a new database or open an existing one.

2. Enter the new database name and directory path or locate an existing database in the dialog box 
that opens.

3. Open the File menu to choose the source of the information you want to add to the database. You 
may scan a new document into the database or import an existing file.

4. A progress meter displays as the information is added to the database. When the process you 
specified is complete, a dialog box asks if you want to import or scan another document. Select 
Yes to import information in the same manner or No to return to the database.

5. Begin searching for information when you return to the database.

Related Topics

Creating a New Database

Document Processing Options

Importing Existing Files

Opening an Existing Database

Searching Made Relevant



D Creating a New Database

To create a new database:

1. Choose Create New from the Database Login window that appears when PageKeeper first 
opens.

You can also choose New Database... from the File menu.

2. Enter the database name in the New Database dialog that opens -- the .pkp file extension is 
provided for you. Specify the drive and directory for the database location, and click OK.

A window opens to remind you that the creator of a database is automatically logged in as Admin. 
As the Admin user you have full access to the commands in the Admin menu. Click OK to 
continue. The new database opens.

3. Select the Show Folders command from the Window menu. The folder window opens with a 
folder icon labeled The ShoeBox. The ShoeBox displays the names of all the documents that you 
enter into the database until you move them to other folders. 

4. You are now ready to start adding to your database by importing text and graphics from existing 
computer files or by scanning information in directly.

Related Topics

Adding to the Database



D Opening an Existing Database

To open an existing database:

1. Choose Open Other from the Database Login window that appears when PageKeeper first 
opens. 

You can also choose Open Database... from the File menu.

2. Locate the database name with its .pkp file extension in the Open window and click OK. 

3. Type your name into the User Name box of the User Login window or select your name from the 
list if you've logged in before. Click OK.

If you created the database, you can select Admin from the list, but you may want to log in under 
your name for receiving mail (if you're on a network) and to separate your Admin functions from 
your regular use.

If you are logging in for the first time, a window opens to confirm the addition of a new user to the 
database. If your name is shown correctly, click Yes. The next time you open the database you 
can select your name from the User Name list.

Every user of the database can add and delete information from it. Users who share a database 
can send and receive documents and messages to one another.

Related Topics

Network Sharing and Mailing



D Adding to the Database

You can add new files to your database from three sources:

· existing computer files (text and graphics)

· a scanner

· by selecting Recognize/Edit Scanned Docs... or Finish Unattended OCR/Indexing from the File 
menu if you have batched documents for later processing

Regardless of their source, all documents go through essentially the same process:

· Initial scan or import

· Zoning, optical character recognition (OCR), editing (This step can be skipped entirely for text-
only files.) 

· Indexing

There are two points in the import process where you can stop the process in order to batch jobs: 

· between the scanning/import phase and the zoning/OCR/editing phase

· between the zoning/OCR/editing phase and the indexing phase

You can edit files as you add them to the database, but once they are saved to the database, you can 
only edit them by exporting them to another application and then importing them again.

Related Topics

Document Processing Options

Importing Existing Files

Managing the Import Process

Scanning New Documents



D Importing Existing Files

You can add files created with other software into the database. You can import files in a number of 
popular word-processing formats and you can recognize TIFF, PCX or DCX image files scanned as 
black and white line art at 200 dpi or better. PageKeeper also supports low-resolution fax images; you 
can import fax images from your hard disk or network directories and PageKeeper uses its AnyFax 
technology to recognize them.

Related Topics

Importing a Group of Files

Importing a Text File

Importing an Image

Supported File Formats



D Importing an Image

To add an image file to the database:

1. Choose Import from File... from the File menu.

The Import from File dialog box displays.

2. Check that the format for the file you are importing appears in the List Files of Type list box.

3. Select AUTO so that PageKeeper automatically selects the correct import filter. If the format 
cannot be recognized, an error is reported and the import is canceled.

4. Click the name of the file to import and click OK.

You can change the active drive and directory in this dialog box.

5. Click the options you want in the Import File dialog box. 

6. Choose the Options... button in the Scan dialog and verify that your options are set up correctly for 
this scanning job.

Check that the page orientation and page layout selections are appropriate for the image. 

7. Click OK in the Options dialog to return to the Scan dialog and click OK in the Scan dialog to start 
the scanning process.

The newly imported documents appear in the default folder, The ShoeBox. PageKeeper names 
documents with the three most comon subject words and adds a number if necessary to make 
the name unique.

Related Topics

Edit/Verify Text

Managing the Import Process

Organizing the Database

Set Recognition Zones

Supported File Formats



D Importing a Text File

To add a text-only file to the database:

1. Choose Import from File... from the File menu.

The Import from File dialog box displays.

2. Check that the format for the file you are importing appears in the List Files of Type list box.

3. Select AUTO so that PageKeeper automatically selects the correct import filter. If the format 
cannot be recognized, an error is reported and the import is canceled.

4. Click the name of the file to import and click OK.

You can change the active drive and directory in this dialog box.

5. Click the options you want in the Import File dialog box and then click OK. 

You can choose to defer and batch the editing process with the Scan in Batch Mode option. You 
can defer and batch indexing with the Index in Batch Mode option. 

6. A progress meter displays as the information is being indexed. When the import process is 
complete, a dialog box displays asking if you want to import another file.

7. Click Yes if you want to add additional files and No if you want to return to the database.

8. The newly imported documents appear in the default folder, The ShoeBox. 

PageKeeper names documents with the three most common subject words and adds a number if 
necessary to make the name unique.

Related Topics

Managing the Import Process

Organizing the Database

Supported File Formats



D Importing a Group of Files

If you want to import a lot of files, select the Scan in Batch Mode option in the Import File dialog box. 
This returns you to the Open Database dialog box after the initial import of the file so that you can do all 
your selecting at the beginning of the import process. 

When you have finished selecting the files you want, you'll resume the process by selecting the 
Recognize/Edit Scanned Docs... option or the Finish Unattended OCR/Indexing option from the File 
menu. 

· If you are setting recognition zones or editing files, select the Recognize/Edit Scanned Docs... 
option to continue processing.

· If you are importing text-only files without changes, select the Finish Unattended OCR/Indexing 
option to continue processing.

Related Topics

Managing the Import Process

Organizing the Database

Supported File Formats



D Supported File Formats

PageKeeper recognizes text in image and fax files. You can recognize a TIFF or PCX file that was 
scanned as black and white line art at 200 dpi or better. PageKeeper also supports most popular fax file 
formats; you can recognize faxes directly from your hard disk. 

You can import files to the following formats:

¨ TIFF

¨ PCX

¨ DCX

¨ Ami Professional 1.1, 1.2, 2.0 ¨ PeachText 5000 2.1

¨ ASCII ¨ PFS:First Choice 1.0, 2.0

¨ ASCII Standard ¨ PFS:Prof. Write 1.0, 2.0, 2.2

¨ ASCII Stripped ¨ PFS:WRITE Ver C

¨ Dec.Dx ¨ Q&A Write 3.0

¨ DisplayWrite (DCA/RFT) ¨ Rapid File 1.2

¨ EBCDIC ¨ Samna Word IV & IV+

¨ Enable 1.1, 2.0, 2.15 ¨ Signature

¨ Excel 3.0 ¨ Volkswriter 3, 4

¨ Excel Text ¨ Volkswriter Dlx 2.2

¨ Framework III 1.0, 1.1 ¨ Wang PC 3.0

¨ GSA NAVY DIF ¨ Windows Write 3.0

¨ HP Advance Write Plus ¨ Word For Windows 1.0, 2.0

¨ IBM Writing Assist 1.0 ¨ WordPerfect 4.1, 4.2, 5.0, 5.1

¨ Lotus .WK1. ¨ WordPerfect For Windows

¨ Lotus Manuscript 2.0, 2.1 ¨ WordStar 2000, Rel 3.0, Rel 3.5

¨ Microsoft RTF ¨ WordStar 3.3, 3.31, 3.45, 4.0, 5.0, 5.5, 6.0, 7.0

¨ Microsoft Word.3.0, 3.1, 4.0, 
5.0, 5.5

¨ XyWrite III

¨ MultiMate 3.3 ¨ XyWrite III Plus

¨ MultiMate Adv. 3.6

¨ MultiMate Adv. II 3.7

You can export files in the following formats:

¨ TIFF

¨ TIFF Type II

¨ TIFF Type IV



¨ Ami Professional 1.1, 1.2, 2.0 ¨ PeachText 5000 2.1

¨ ASCII ¨ PFS:First Choice 1.0, 2.0

¨ ASCII Standard ¨ PFS:Prof. Write 1.0, 2.0, 2.2

¨ ASCII Stripped ¨ PFS:WRITE Ver C

¨ Dec.Dx ¨ Q&A Write 3.0

¨ DisplayWrite (DCA/RFT) ¨ Rapid File 1.2

¨ EBCDIC ¨ Samna Word IV & IV+

¨ Enable 1.1, 2.0, 2.15 ¨ Signature

¨ Excel 3.0 ¨ Volkswriter 3, 4

¨ Excel Text ¨ Volkswriter Dlx 2.2

¨ Framework III 1.0, 1.1 ¨ Wang PC 3.0

¨ GSA NAVY DIF ¨ Windows Write 3.0

¨ HP Advance Write Plus ¨ Word For Windows RTF

¨ IBM Writing Assist 1.0 ¨ WordPerfect 4.1, 4.2, 5.0, 5.1

¨ Lotus .WK1. ¨ WordPerfect For Windows

¨ Lotus Manuscript 2.0, 2.1 ¨ WordStar 2000, Rel 3.0, Rel 3.5

¨ Microsoft RTF ¨ WordStar 3.3, 3.31, 3.45, 4.0, 5.0, 5.5, 6.0, 7.0

¨ Microsoft Word.3.0, 3.1, 4.0, 
5.0, 5.5

¨ XyWrite III

¨ MultiMate 3.3

¨ MultiMate Adv. 3.6

¨ MultiMate Adv. II 3.7

Related Topics

Managing the Import Process

Organizing the Database



D Scanning New Documents

You can scan images and text directly into PageKeeper. 

With an automatic document feeder (ADF) and PageKeeper's automatic processing features, you can 
scan a batch of forms and have PageKeeper automatically save each form as a separate document with 
a unique document name. Also, you can scan several sets of multi-page documents at once and have 
PageKeeper automatically save each set with a different document name. This feature enables you to 
save time and reduce the amount of information you must provide to PageKeeper.

Note that when scanning in a multi-chapter document, you will probably want to scan each chapter as a 
separate document for more effective searching of the information.

You can use the Scan in Batch Mode option in the Scan dialog box to do all your scanning at one point 
and save recognition and editing for later. 

Related Topics

Document Processing Options

Managing the Import Process

Scan in Batch Mode

Scanning a new document into the database

Using Recognition Tools



D Scanning Steps

1. Make sure that your scanner is set up properly.

2. Select the Scan Setup... command from the File menu and select your scanner type from the 
Scanner list in the dialog box that opens.

3. Put the document in the scanner.

4. Choose Scan... from the File menu and select the options you want or choose Quick Scan to use 
the settings from the last time you scanned.

5. Choose the Options... button in the Scan dialog and verify that your options are set up correctly for 
this scanning job.

Check that the page orientation, page layout, paper size, and brightness levels are appropriate. 

6. Click OK in the Options dialog to return to the Scan dialog and click OK in the Scan dialog to start 
the scanning process.

7. Progress meters display as the information is being added to the database. When the import 
process is complete, a dialog box displays asking if you want to scan another file.

6. Click Yes if you want to add additional files in the same manner and No if you want to return to 
the database.

New documents appear in the default folder, The ShoeBox. PageKeeper names each document with its 
three most common subject words. A number is added if necessary to make the name unique.

Related Topics

Document Processing Options

Managing the Import Process

Scan in Batch Mode

Scanning a new document into the database

Using Recognition Tools

Organizing the Database



D Managing the Import Process

Use the Recognize/Edit Scanned Docs... and Finish Unattended OCR/Indexing commands in the File 
menu to finish batch processing.

Choose these commands to do the recognition, editing and indexing of the documents you deferred or 
batched with your selections in the Import File or Scan settings dialog box. 

Whether you use Recognize/Edit Scanned Docs... and Finish Unattended OCR/Indexing or both 
depends on your previous selections.

Related Topics

Batching Scanning and Indexing

Document Processing Options

Finish Unattended OCR/Indexing

Recognize/Edit Scanned Documents

The Shoebox Holds New Documents



D Recognize/Edit Scanned Documents

The Recognize/Edit Scanned Docs... option in the File menu imports your text and image files and 
scanned documents so that you can control the recognition and/or editing processes. This command re-
opens files and documents that you stored with the Scan in Batch Mode option with selections for the 
Set Recognition Zones and/or Edit/Verify Text processing options.

 Documents are presented for zoning and/or editing in the order that they were initially imported. 

From the Import Document window, you'll select the Recognize button to begin the recognition and OCR 
phases if you're setting the zones. You'll select the Finish Import command from the File menu of the 
Import Document window when you've finished editing.

Related Topics

Batching Scanning and Indexing

Document Processing Options

Finish Unattended OCR/Indexing

The Shoebox Holds New Documents



D Finish Unattended OCR/Indexing

The Finish Unattended OCR/Indexing option in the File menu finishes automatic recognition and/or 
indexing. This command automatically processes files and documents that you stored with the Index in 
Batch Mode option.

It also finishes automatic OCR of image files or scanned documents that you stored with the Scan in 
Batch Mode option without any processing options selected.

You will see an indexing progress meter as each document that was batched is being processed. If you 
select Cancel from a window with this meter, the documents that were already completed will be in the 
database. The document that was in the midst of being processed and all others waiting to be indexed 
are stored in batch again in their unindexed state. You can reselect Finish Unattended OCR/Indexing at 
a later point to finish their processing.

Related Topics

Batching Scanning and Indexing

Document Processing Options

Recognize/Edit Scanned Documents

The Shoebox Holds New Documents



D Batching Scanning and Indexing

In many cases, you will want to take advantage of both of the batch processing options:

¨ Scan in Batch Mode

¨ Index in Batch Mode

If you chose both Scan in Batch Mode with processing options and Index in Batch Mode, you will first 
select Recognize/Edit Scanned Docs... and then select Finish Unattended OCR/Indexing to complete 
the processing of files and scanned documents.

Select Recognize/Edit Scanned Docs... when you want to specify how the document is zoned and/or 
edited. Documents are presented for zoning and/or indexing in the order that they were initially 
imported.

From the Import Document window, you'll select the Recognize button to begin the recognition and OCR 
phases if you're setting the zones. You'll select the Finish Import command from the File menu of the 
Import Document window when you've finished editing.

Select Finish Unattended OCR/Indexing when you want to complete the process of adding the files and 
documents to the database.

Related Topics

Document Processing Options

Finish Unattended OCR/Indexing

Recognize/Edit Scanned Documents

The Shoebox Holds New Documents



D The Shoebox Holds New Documents

New documents appear in the default folder, The ShoeBox. PageKeeper automatically compresses any 
image files and names documents with their three most common subject words. A number is added if 
necessary to make the name unique. 

Related Topics

Organizing the Database



D Organizing the Database

PageKeeper's searching capabilities mean that you do not have to organize your database to keep 
information readily available. You may find, however, that creating levels of folders to group together 
common documents provides a useful visual organization. Each database can be thought of as a file 
cabinet that you organize into folders as you see fit. 

PageKeeper lets you keep multiple "copies" of the same document in different folders without increasing 
your disk space consumption; you can cross-reference the documents in as many folders as you like.

The ShoeBox is the folder that holds the documents that you've added to the database until you relocate 
them. Note that folders and the documents within them are listed alphabetically. 

Related Topics

Saving Search Results

Organizing Documents in Folders 

Importing Existing Files

Sharing a Database



D Organizing Documents in Folders 

Make the folder window active to begin organizing the documents in the folder window.

If it is not visible, choose Show Folders from the Window menu or click the Folders button in the button 
box.

The folder window displays with the name of the database in its title bar. The ShoeBox is the default 
folder that appears when the database is opened. If you enlarge the folder window, you can see that 
creation dates and times are displayed. 

Related Topics

Copying Documents

Creating Folders

Deleting Documents and Folders

Expanding and Collapsing Folders

Moving Folders and Documents

Re-indexing After Deleting

Renaming Folders and Documents



D Renaming Folders and Documents

To rename a document or folder, double-click the name (not the icon) of a folder or document or select it 
and choose Edit Name... from the Folders menu. An entry box allows you to overtype or edit the name; 
press Enter when you are finished. 

You can use up to 47 characters for the name. You can use the Escape key to close the edit box without 
changing the name. 

Related Topics

Copying Documents

Creating Folders

Deleting Documents and Folders

Expanding and Collapsing Folders

Moving Folders and Documents

Re-indexing After Deleting



D Creating Folders

To create a new folder

Select Create Folder... from the Folders menu. A Create Folder dialog box allows you to enter the name 
of the new folder and select its level and location. Choose Top level (No Parent) if you want the folder to 
be visible when the folders are collapsed. Type a new name into the Folder Name box and click OK.

To create a sub-folder of an existing folder

Highlight a folder before selecting Create Folder... and it automatically appears as the Specific Parent of 
the new folder. Type the new name into the Folder Name box and click OK.

Related Topics

Copying Documents

Deleting Documents and Folders

Expanding and Collapsing Folders

Moving Folders and Documents

Re-indexing After Deleting

Renaming Folders and Documents



D Expanding and Collapsing Folders

To open a folder

Double-click the folder icon or select a folder and select Expand/Collapse from the Folders menu or its 
shortcut key, the Space bar. 

To close a folder

Double-click the folder icon again or select a folder and the Expand/Collapse command or its shortcut 
key, the Space bar. The Expand/Collapse command and the Space bar act as a toggle for opening 
closed folders or closing open folders.

To open all folders and documents within a selected folder

Select Expand Branch from the Folders menu.

To close all folders and documents within a selected folder

Select Collapse Branch from the Folders menu.

To open all folders

Choose Expand All from the Folders menu.

To close all branches

Choose Collapse All from the Folders menu.

Related Topics

Copying Documents

Creating Folders

Deleting Documents and Folders

Moving Folders and Documents

Re-indexing After Deleting

Renaming Folders and Documents



D Moving Folders and Documents

To move a document or folder

Click its icon and drag it to the icon of the new location.

To select multiple adjacent icon

Shift-click the first and last in the sequence. 

To select multiple icons that are not adjacent

Ctrl-click each one. 

To    move a document to another folder or change the hierarchy of a folder

Select it and choose the Move... command in the Folders menu. 

In the dialog box that opens, select Specific Folder and enter the name of the receiving folder to move a 
document or folder to that location. 

Select Top Level to move the document or folder up to the top level of the folder hierarchy.

Related Topics

Copying Documents

Creating Folders

Deleting Documents and Folders

Expanding and Collapsing Folders

Re-indexing After Deleting

Renaming Folders and Documents



D Copying Documents

To copy a document into a different folder

Select it, Ctrl-click and drag its icon to another location.

Or

Select the document and select Copy... from the Folders menu. Copy it to a folder by selecting Specific 
Folder and entering the folder name. 

You can also select Top Level in the Copy dialog box to copy a document to the top level of the folder 
window.

You can keep as many copies of a document as you want without slowing PageKeeper, but once you 
decide a document is not useful, you may want to delete it from the database to make the index smaller 
and make database searches faster. 

Related Topics

Creating Folders

Deleting Documents and Folders

Expanding and Collapsing Folders

Moving Folders and Documents

Re-indexing After Deleting

Renaming Folders and Documents



D Deleting Documents and Folders

To delete a folder or a document

Select it and then click the trash icon in the button box or by choose Delete from the Folders menu. 

If the document you are deleting is the last copy in the database, a dialog box opens asking you to 
confirm that you want to remove the document from the database. You cannot delete The ShoeBox.

Related Topics

Copying Documents

Creating Folders

Expanding and Collapsing Folders

Moving Folders and Documents

Re-indexing After Deleting

Renaming Folders and Documents



D Re-indexing After Deleting

Periodically, and especially after a number of documents have been deleted from the database, the 
Admin user should re-index the database to expunge all the files that were associated with deleted 
documents. 

Related Topics

Deleting Documents and Folders

Updating the Database Index



D PageKeeper Indexes

When you perform a search you can specify which of the four types of PageKeeper indexes are 
included:

· the index of documents in the database

· the index of document annotations

· the index of local external files 

· the index of network external files 

The index of database documents and the index of annotations is created and updated automatically as 
you add and delete information and notes to the database. Indexes for files on your hard disk or network 
drives are generated at your request.

The document and annotations indexes must be searched from the database where they were created. 
The local external index is specific to the workstation where it was created. You can create your own 
network external index or share one with other users (as long as they share the same drive mappings to 
those files).

Related Topics

Indexing a Network or Hard Disk

Indexing Hard Drive or Network Files

Updating External File Indexes

Updating the Database Index



D Indexing a Network or Hard Disk

You can create an index of external files on your local hard drive with the (Re-)Index Files... option in the 
Admin menu. You can specify specific directories for the index, which reduces the amount of time 
needed for searching. PageKeeper indexes the file types that are most suitable, automatically excluding 
program file extensions such as .COM, .EXE, .DLL, .PIF, .HLP, and .BAT. (Floppy drives and removable 
drives such as Bernoulli box, magneto-optical or WORM cannot be indexed.)

Network drives are indexed with the same method, but a user must be logged in as Admin to create an 
index of network external files. 

You can also control when the indexes of the external files are created so that you do not freeze up your 
computer resources while waiting for the index to be generated. You might, for example, elect to index 
your hard disk as an overnight job.

Related Topics

How to Index Hard Drive or Network Files

Updating External File Indexes

Updating the Database Index



D Indexing Hard Drive or Network Files

1. Choose (Re-)Index Files... from the Admin menu.

2. Specify whether to index files on the Local Drives or Network Drives in the dialog box, and click 
OK.

Only the creator of the database can index and re-index network external files.

3. Click New... in the dialog box that asks if you want to locate an existing index or open a new one . 

4. Specify the name of the index file in the Save As dialog box that displays; .pkx is the default 
PageKeeper extension for an index file. 

5. Select the directories that you want to index in the dialog box that displays. 

6. Click OK to start indexing the files when you have selected all the directories you want to 
include, . 

Click Cancel if you do not want to index the files.

PageKeeper shows the progress of the indexing. If you must stop the process for some reason, 
select Stop from this progress window; everything that has been indexed up to that point will be 
saved to the index.

Related Topics

Updating the Database Index



D Updating External File Indexes

The indexes for local external files and network external files are only updated at your request. When 
you update an external index, PageKeeper only re-indexes the files that were modified since the last 
time the index was updated.

To update an external file index:

1. Choose (Re-)Index Files... from the Admin menu.

Only the Admin user for the database has the option of re-indexing network files.

2. Choose whether you want to re-index the Local Drives or Network Drives in the dialog box that 
displays and click OK. 

1. Choose (Re-)Index Files... from the Admin menu.

Only the Admin user for the database has the option of re-indexing network files.

2. Choose whether you want to re-index the Local Drives or Network Drives in the dialog box that 
displays and click OK. 

3. If an index is not automatically located, a dialog box opens asking if you want to locate an existing 
index or open a new one. Click the Locate... option.

4. Add or remove directories for indexing from the Directories to be (Re-)Indexed list box that 
displays previously indexed directories in the dialog box that opens. 

5. Click OK to start indexing the files.

Click Cancel if you do not want to index the files.

Click Add to include new directories in the index.

Click Remove to take a directory out of the index.

A dialog box shows the progress of the indexing. If you must stop the process for some reason, 
you can select Stop from this window; everything that has been indexed up to that point will be 
saved to the index.

Related Topics

Indexing Hard Drive or Network Files

Updating the Database Index



D Updating the Database Index

Your database index is automatically updated for searching as you add and delete information. The 
Admin user should periodically re-index the database, however, to finish expunging files associated with 
deleted documents and free up disk space. The database should also be re-indexed after a software 
upgrade or system crash. Since this update is only done at the Admin user's request, it is typically done 
as an overnight or weekend job.

To update a database index, the Admin user can choose Re-Index Database from the Admin menu. 
Before the new index is created, a backup copy of the previous database index is saved so that 
PageKeeper can re-establish it if you choose to stop the re-indexing or if there are errors during the 
process. 

If you cancel during re-indexing by selecting Cancel in the progress meter window, PageKeeper 
restores the previous index. 

Related Topics

Indexing Hard Drive or Network Files

Updating External File Indexes



D Maintaining the System

The Admin menu includes a tool for database system maintenance, the Recondition Database 
command. Only the Admin user for the database has access to this command.

Select Recondition Database from the Admin menu periodically to let PageKeeper optimize database 
files and improve performance.

Technical Support may also ask you to use the Recondition Database command in the event of a 
system crash or database corruption.



º Relevance is Graphically Displayed

PageKeeper presents the documents that satisfy your search request in order of relevance and 
graphically displays the closeness of the match to your query with a colored relevance bar for each 
document in the list.

Documents that are most highly relevant to your search request are highlighted with red, documents 
that are moderately relevant are highlighted with green, and documents that are somewhat relevant are 
highlighted in blue. Relevance ratings are independently calculated, so every color category is not 
represented in every search. It is possible, for example, to have search results that only return highly 
relevant and somewhat relevant documents.

The Document Agent Search provides an additional graphic display, called the content pathways 
diagram. The content pathways diagram shows you how other documents relate to the content of the 
agent document along three content pathways. 

Related Topics

Searching Made Relevant--Quick Start

How Weighted Relevance Retrieval Works

What Gets Searched

Selecting a Search Method

Using the Weighted Word Search

Using the Weighted Boolean Search

Using the Document Agent Search

Saving Search Results



º Searching Made Relevant--Quick Start

To search for information in the database:

1. Select the search method you want to use from the Search menu or button box.

2. Fill in the dialog box that opens with the search terms (the document name is automatically 
entered for the Document Agent Search), select the indexes you want to search, and press Enter 
or click OK.

PageKeeper presents the documents that satisfy your search request and graphically displays 
the closeness of the match to your query with a colored relevance bar for each document in the 
list. (Red = most relevant, green = moderately relevant, blue = somewhat relevant.) 

3. Double-click the icon next to the document name in this list to open it.

4. You can save or re-organize the results of your search with the options in the Results menu. If 
you want to save only the most relevant documents, you can create a new folder and drag and 
drop the documents you want into it.

Related Topics

Relevance is Graphically Displayed

How Weighted Relevance Retrieval Works

What Gets Searched

Selecting a Search Method

Using the Weighted Word Search

Using the Weighted Boolean Search

Using the Document Agent Search

Saving Search Results



º How Weighted Relevance Retrieval Works

With most text retrieval systems, your search query is returned with an undifferentiated and unordered 
list of the documents that approximate your request. 

PageKeeper addresses the problems inherent in traditional mathematical search methods with 
Weighted Relevance Retrieval. There is no penalty for adding information to your search because every 
results list is ranked by relevance. PageKeeper understands when a word you've asked for is important 
in a document and it understands how useful your search word is in differentiating one document from 
another in the database as a whole.

Adding words to your search helps clarify your query and distinguish the documents you want from 
other documents in the database. Words that turn out to add little in terms of importance or uniqueness 
are ignored.

Related Topics

Relevance is Graphically Displayed

Searching Made Relevant--Quick Start

What Gets Searched

Selecting a Search Method

Using the Weighted Word Search

Using the Weighted Boolean Search

Using the Document Agent Search

Saving Search Results



º What Gets Searched

Because PageKeeper automatically indexes every important word in a document, you get full-text 
retrieval when you use the Weighted Word Search and the Weighted Boolean Search. Only the noise 
words, such as and and the are left out. See the topic Noise Words for this list and more information. 
PageKeeper is intelligent in its treatment of hyphenated words; it can recognize words broken at the end 
of a text line as a single word.

Related Topics

How Hyphenations Are Handled

How Weighted Relevance Retrieval Works

Noise Words

Relevance is Graphically Displayed

Saving Search Results

Searching Made Relevant--Quick Start

Searching with Hyphenations

Selecting a Search Method



º Selecting a Search Method

When you know the word or words you want to locate or the topic you want to explore, use the 
Weighted Word Search. You can also use the Weighted Boolean Search to restrict your search, but 
generally you'll find that the documents with the highest (red) relevance rating in a Weighted Word 
Search provide a similar result.

If you've found one document you like and want to see others with a similar content, use the Document 
Agent Search. You can also use the Document Agent Search for a quick analysis of the major subject 
categories of a document.

Related Topics

Weighted Word Searching

Weighted Boolean Searching

Document Agenting

Modified Document Agent Search



º Weighted Word Searching

Doing a Weighted Word Search is easy. You simply type in as many words as you want about your 
search subject and PageKeeper's retrieval engine locates those words within the database. The results 
PageKeeper returns are much more significant than a typical mathematical "OR" search, however, 
because PageKeeper measures the relevance of documents to each search.

Using the Weighted Word Search with several terms in the search list is analogous to using a library's 
catalog system to look up several possible subject listings for a particular topic. The advantage of the 
Weighted Word Search is that you can do your searching in one step and the results are printed in order 
of relevance ¾ not alphabetically. 

Related Topics

Document Agenting

Modified Document Agent Search

Saving Search Results

Using the Weighted Word Search

Weighted Boolean Searching

Weighted Word Searching

What Gets Searched



º Weighted Boolean Searching

When you use the Weighted Boolean Search, you are specifying that at least two of the words in your 
search must be in a single document, with a valid word on each side of the AND operator. So, for 
example, if you entered the terms cars AND trucks, you would only get results for documents that 
discuss both. 

You can add to the search by adding additional words that use the OR operator. For example, if you 
entered cars or motorcycles AND trucks in the Weighted Boolean Search window, your results could 
include:

· documents that discuss cars and trucks 
· documents that discuss motorcycles and trucks 

Documents that discuss cars and motorcycles would not meet the search conditions.

Related Topics

Document Agenting

Saving Search Results

Using the Document Agent Search

Using the Weighted Boolean Search

Using the Weighted Word Search

Weighted Word Searching

What Gets Searched



º Document Agenting

Use the Document Agent Search when you have one useful document and you'd like to see others like 
it. Using the Document Agent Search is analogous to finding one pertinent book listing in a library 
catalog, copying down its Dewey decimal number and then heading straight for its location in the stacks 
to see if there are any other useful references right next to it.

PageKeeper analyzes the content of the document you like so that it can act as an agent and find others 
that focus on the same subjects. PageKeeper analyzes the content, not the form of the document. So, 
for example, using a memo about Employee Training as an agent will not necessarily return another 
memo; such a search might return a magazine article about training methods used at various 
companies.

When you do a Document Agent Search, PageKeeper provides a content pathways diagram ¾ a visual 
display of the document's major subject areas and the relationship of other documents to it. 

Related Topics

Modified Document Agent Search

Saving Search Results

Using the Document Agent Search

Using the Weighted Boolean Search

Using the Weighted Word Search

Weighted Word Searching

What Gets Searched



º Modified Document Agent Search

You can make any of the documents in the content pathways a new agent document so that you can 
quickly and easily explore new topic areas without conducting a new search. This allows you to further 
explore the contents of the documents in the results list and the content links between them.

When you select one of the thumbnails and choose Make New Agent in the Results menu, you'll see the 
content pathways for that document. Different documents from the results list appear as thumbnails 
according to their relevance along the new pathways. You can continue choosing new agent documents 
to explore different paths. Select Previous Agent from the Results list as many times as necessary to 
backtrack to your starting point.

Related Topics

Document Agenting

Saving Search Results

Using the Document Agent Search

Using the Weighted Boolean Search

Using the Weighted Word Search



Using the Weighted Word Search

1. Choose Weighted Word Search... from the Search menu.

The Weighted Word Search dialog box displays.

2. Type the word or words you want to search for in the field labeled Word(s). 

To search for multiple words, just type a space between each one. Add as many synonyms or 
variants of a word as you like. For example, computer PC workstation. 

3. Specify the indexes to search.

See Building a Database for more information about locating and creating external indexes. 

4. Click OK to start the search.

The Weighted Word Search results window displays the search words in a header at the top of 
the results list of documents.

5. Open a document from the list by double-clicking its icon, highlighting it and choosing Open 
Document from the File menu, or highlighting it and pressing Enter. 

6. Find the locations of the search words in the document when it is in Text View by selecting Go to 
Search Word from the Document menu or use the Tab key as a shortcut. 

Related Topics
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º Stepping Through the Search Words

With the document window active, you locate the first occurrence of a search word by selecting Go to 
Search Word from the Document menu or using the Tab key as a shortcut. Use Previous Search Word 
to move back to the last occurrence or use Shift+Tab as a shortcut. 

When PageKeeper has located all the search words at either end of the text, it opens a dialog that asks 
if you want to continue at the other end. Select Yes to continue or No to stop locating search words.

If you selected the Annotations index in your search request, PageKeeper proceeds into the first 
annotation for that document if a search word is present. It continues to open annotations until all the 
search words have been located. 

Related Topics

How Hyphenations Are Handled

Saving Search Results

Searching with Hyphenations



º How Hyphenations Are Handled

In order to intelligently analyze the content of your documents and provide consistency in its indexing, 
PageKeeper is conservative in its recognition of hyphenated words. 

It also uses its intelligence to recognize whole words, even if they are hyphenated for a line break. For 
example, if PageKeeper encounters the term moni-tor in the text, it recognizes that the word was broken 
for a line break and indexes it as monitor. 

With other hyphenated words, PageKeeper goes through several steps to determine how indexing the 
word will be most useful and consistent. 

· If the hyphenated word is a standard American usage according to its dictionary, PageKeeper 
leaves it as is. For example, father-in-law.

· When it encounters a non-standard hyphenation, PageKeeper takes the hyphen out and checks 
to see if it' s a common English word. For example, if it comes across the term net-work, it knows 
that network (without the hyphen) is the common English spelling and the word is indexed as 
such.

· PageKeeper also checks to see if a term works as two separate words. For example, 
PageKeeper indexes the term left-brain as left brain.

· In other cases, PageKeeper assumes that the word is a specialized or idiosyncratic hyphenation. 
It leaves the hyphen in and indexes it as it was in the document. This includes words with four or 
more hyphenations. For example, PageKeeper indexes the term pyscho-babble-babba-loo as 
pyscho-babble-babba-loo.

Related Topics
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º Searching with Hyphenations

PageKeeper' s treatment of hyphens will steer you to the common usage and help you access 
documents with the same terminology even if hyphenations have been misapplied in the text. When you 
are searching for a hyphenated word, if a search with the hyphen doesn' t work, try searching for the 
term as a single word without a hyphen. For example, in a PageKeeper index, on-line is listed as online.

Alternately, although creative writers will create hyphenated expressions, unless the hyphenation is very 
common, you should search for the term as two separate words. For example, when searching for the 
term network-sharing, enter network and sharing.

Related Topics

How Hyphenations Are Handled

Saving Search Results

Stepping Through the Search Words



º Using the Weighted Boolean Search

To do a Weighted Boolean Search:

1. Choose Weighted Boolean Search... from the Search menu.

2. Enter up to six words for your search, three on each side of the AND operator. 

At least one word on each side of the AND operator must be found in a document for it to be 
returned in the results list.

3. Specify the indexes to search.

See Building a Database for more information about locating and creating external indexes. 

4. Click OK to start the search.

The Weighted Boolean Search results window displays the search words in a header at the top of 
the list of resulting documents. 

5. Open a document from the list by double-clicking its icon, highlighting it and choosing Open 
Document from the File menu, or highlighting it and pressing Enter.

6. Find the locations of the search words in the document when it is in Text View by selecting Go to 
Search Word from the Document menu or using the Tab key as a shortcut. 

Related Topics
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º Using the Document Agent Search

To do a Document Agent Search:

1. Select the document that you want to use as an agent for finding other documents with similar 
contents.

2. Choose Document Agent Search... from the Search menu.

The title of the agent document you selected appears in the Document Agent Search window.

3. Specify the indexes to search.

4. Click OK to start the search.

PageKeeper displays a split screen with the content pathways diagram displayed on the left and 
the document results list displayed under the agent document's name on the right. 

5. Click and drag the split bar to see more of the content pathways diagram or the results list.

When you click any of the thumbnails in a content pathway, its image is highlighted and its title in 
the results list is located and highlighted.

The order of documents in the results list differs from the order in the content pathways because 
it shows the relevance of each document to the contents as a whole.

6. Open a document from either the content pathways diagram or the results list by double-clicking 
its thumbnail or document icon, or by highlighting either and selecting Open Document from the 
File menu.

Related Topics
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º Make Agent Document

Explore different content pathways and the links between the documents in the results list by selecting 
another document in the results list as an agent document. To do this, select a document and choose 
Make Agent Document from the Results menu or use the Shift+double-click shortcut.

Return to your original document agent by selecting Previous Agent Document.

Related Topics

Document Agenting



º Saving Search Results

You can save the results of your searches of database documents (in alphabetical order) by selecting 
Create Results Folder from the Results menu. A new folder is created in the folder window and all the 
documents in the results list are copied alphabetically into the folder. The folder's name includes the 
search type, an identifying number, and the search terms. For example, Document Agent 1: US 
Industrial Outlook '92.

Note that if there are external files in the results list, they are not added to the results list. (External files 
are identifiable by their pathname in the results list and they have a different icon than database 
documents.)

As an alternative, you may want to save only the most highly relevant database documents in a folder. 
To do this:

1. Create a new folder with the Create Folder... option from the Folder menu.

Fill in the dialog box that opens.

2. Select the document or documents that you want to add to the folder.

3. Drag and drop the icon for the selected document or documents into the icon of the folder you 
created.

After PageKeeper copies the documents into the folder, they appear in alphabetical order.

Related Topics

Document Agenting
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· Network Sharing and MailingQuick Start

There are a number of ways that you can use PageKeeper's network capabilities within your database:

· To send a copy of one or more documents, choose Show Post Office from the Window menu. 

To send to an individual, drag the document icon into the mailbox

To send a copy of a document to a group, select a range of mailboxes by Shift-clicking or 
dragging with the mouse; select and deselect multiple mailboxes by Ctrl-clicking.

Write your message in the Message Text dialog box that displays and click Send.

· To view the documents sent to you, choose Show Mail Box from the Window menu and double-
click the icon of the document you want to display.

The message envelope icon will have a red address label when there is a message inside; 
double-click the envelope icon on the right side of the window to view the message text. Once 
you have read the message or opened the document, the icon changes to an opened envelope.

Related Topics

Database Security

ScanningandIndexingSimultaneously.83

Sharing a Database

Sharing the Indexes

User Access
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· User Access

Users who have network access to a PageKeeper database can log in by simply typing their name into 
the User Name box in the initial User Login window.

Related Topics

Database Security

Opening an Existing Database

Sharing a Database

Sharing the Indexes

Using Mail



· Using Mail

Every user of a PageKeeper database is given a mailbox listing in the Post Office at login. Database 
users can send and receive copies of database documents with accompanying messages. You can use 
this feature to alert other users to changes to the database and to simplify your workflow in general.

Related Topics

Sharing a Database

Sharing the Indexes

User Access

Sending Mail

Reading Mail

Suggested Uses for this Feature



· Sending Mail

You can send messages and documents to people on your network. You can mail any number of 
documents to any number of users without consuming more disk space for the documents. 

To mail documents:

1. Choose Show Post Office from the Window menu. 

2. Drag the documents you want to mail into the user's mailbox, or specify a group and drag the 
documents into the Group mailbox. You can click and drag any document icon from any 
PageKeeper window and send it to other users.

3. Type into the Subject and/or Message boxes of the Message Text window that opens after you 
place documents in a mailbox. Click Send.

The information you type into the Subject box will display in the recipient's mailbox window. The 
envelope icon for the mail you sent will have a red address window in the recipient's mailbox 
window if you have included a message.

Related Topics

Reading Mail

Suggested Uses for this Feature



· Reading Mail

You can specify that the computer beep when you receive a new message by choosing Beep for New 
Mail from the Options menu.

To view the messages sent to you:

1. Choose Show Mailbox from the Window menu to see a the list of messages and documents 
mailed to you.

The left side of the window displays thumbnails of all documents in the mailbox. 

The right side displays a list of all documents received, any message subject text, and the date 
and time received. New documents display with an unopened envelope; if there is a message 
attached, the envelope has a red address window. 

2. Double-click the envelope icon or select Read Message Text... from the Mail menu to read a 
message attached to documents. 

The envelope icon changes to indicate that a message has been read or a document opened.

3. Double-click a document icon on the right side of the window to display it in Text View mode; 
double-click a document thumbnail on the left side of the window to view it in Image View mode. 

3. Click OK when you have finished viewing the message.

5. Choose Delete Mail to delete a message and associated documents from the mailbox. 

Related Topics

Sending Mail

Suggested Uses for this Feature



· Suggested Uses for this Feature

You can use PageKeeper mail to distribute documents in progress, such as product announcements or 
advertising copy, to other users of the database for efficient review. Each reviewer can open and read 
the document as well as viewing the annotations that other reviewers have made. That way they do not 
have to have to duplicate comments that others have made; they can simply add their own opinions to 
existing notes and create new notes as needed.

Related Topics

Sending Mail

Reading Mail



· Sharing a Database

When you add to the database or change it, your changes become immediately available to other users 
of the database. Such changes include:

¨ importing documents

¨ creating folders

¨ creating and editing notes

¨ deleting folders, notes, documents

¨ changing names of documents and folders

¨ moving documents and sub-folders

You'll see the changes made by other database users approximately once per minute. For example, if 
you are viewing a document that another user has just annotated, the push-pin button for that note 
appears in the document viewing window. You will probably want to establish guidelines so that one 
user doesn't delete a note or the last copy of a document that another user is viewing. 

Related Topics

Establishing Guidelines

Deleting Documents



· Establishing Guidelines

The guidelines you create might include procedures for renaming documents and deleting notes and 
documents from the database. You may want to have a top-level folder for each user of the database, 
so that users can organize documents in their individual folders in the way that works best for them.

When any one user renames a document, its name is changed throughout the database. When any one 
user deletes a document from a folder, it is only removed from that location unless it is the only copy of 
that document. When the last copy of a document is deleted, the document is deleted from the 
database.

Any user logged into a database as Admin can re-index a network external index. You may want to 
establish a guideline that users can add information to the index but not delete it. Or you may want to 
assign a single individual the responsibility of periodically updating and revising the contents of the 
network eternal index.

Related Topics

Deleting Documents

PageKeeper Indexes



· Deleting Documents

You may want to create a Trash folder to store documents proposed for deletion. The Admin user could 
be assigned the responsibility of deleting documents from the Trash at specified intervals. 

Related Topics

Establishing Guidelines



· Database Security

For your ease of use, PageKeeper relies on your own system and network security. When you create a 
database, you are automatically logged in as Admin. Every database can have a different Admin user. 

You may want to log into the same database again under your own name if you are sharing a database. 
This allows you to receive mail in your name, rather than Admin, and allows you to separate specific 
Admin functions from your daily PageKeeper use. Only as Admin can you recondition the database, 
delete database users, index external network files and re-index the database. 

The database's Admin user can remove users from the User Name list with the Delete Users... 
command in the Admin menu.

All database users can also be logged in simultaneously on different systems.

For consistent searching results, it is important that only the database Admin user create and re-index 
database and external network files. External network indexes should only be shared by database users 
who have the same drive mapping to the locations where the files are stored. External network indexes 
should only be shared by database users who have the same drive mapping to the locations where the 
files are stored. If a specific user does not have access to all the information in the index, searches on 
network drives will return results only for the files in the available paths. 

To ensure the integrity of your data, it is very important that all users sharing a database are set up with 
the same transaction file. See Setting Up the Transaction File in Chapter 2 of the PageKeeper Owner's 
Manual.

Related Topics

PageKeeper Indexes

Sharing a Database

Sharing the Indexes

User Access



· Scanning and Indexing Simultaneously

It is possible to scan and index documents at the same time when you are creating a database on a 
network directory. This is especially efficient when you are creating a very large database.

To do this, set one or more scanners up with one or more systems and begin scanning the documents 
with the Scan in Batch Mode and Index in Batch Mode settings selected. Set another system up for 
automatic batch indexing. Because documents can only be completed by the user who deferred them, 
the same user should be logged into each of the systems.

In addition to having a number of systems set up for scanning, you could have a number of systems set 
up for interactive recognition and editing. Access the documents batched for recognition and editing with 
the Recognize/Edit Scanned Docs... command in the File menu. You can recognize, OCR, and edit 
documents one at a time in the order that they were batched.

Access the batched jobs on the single indexing system by selecting Finish Unattended OCR/Indexing in 
the File menu. If there are multiple scanners feeding the database, PageKeeper indexes the documents 
in the order that it receives them into its queue. 

Related Topics

Edit/Verify Text

Scan in Batch Mode

Index in Batch Mode

Finishing Batch Processing



· Sharing the Indexes

To maximize the speed and efficiency of the database, PageKeeper restricts simultaneous access to the 
indexes. If you are sharing a database and one user is indexing a large number of documents, you may 
notice some delay in PageKeeper response when you request access to the index with a search, 
import, or annotation save. PageKeeper responds to other requests to the indexes after indexing an 
individual document.

For the fastest response from PageKeeper, you may want to finish large indexing jobs during non-peak 
hours. Re-indexing database files and network indexes should also be done after normal business 
hours.

Related Topics

Index in Batch Mode

Managing the Import Process



Ñ Using and Sharing InformationQuick Start

You can open a document in text or image view from the folders window, any of the search results 
windows, or your mailbox by double-clicking its icon. 

There are a number of ways that you can use and share the information:

· To read and review a document, use the scroll bars, Next Page command and zoom buttons to 
see the desired regions.

· To print a copy of a document, choose Print from the File menu.

· To copy portions of a document to other documents, use the Edit menu Copy command to copy 
what you want to the clipboard so that you can paste it in a note or another application.

· To add notes that stay with a document, choose the Create Note command or double-click 
anywhere in the text or image. When the note window displays, enter the annotation.

Notes display as push-pin buttons at the top of the document window. To display the contents of a 
note, click the push-pin button or the push-pin icon that appears on the document body in Image 
View.

· To export the document to a file with a different format, choose Export File... from the File menu 
and select the file format you want from the Save As Type list.

Related Topics

Opening and Viewing Database Documents

Copying Information from Documents

Adding Notes

Printing

Exporting Documents

Opening and Viewing External Files



Ñ Opening and Viewing Database Documents

You can open and work with a document in the database from any window that it appears in ¾ folders 
window, results list, content pathways diagram, mailbox ¾ by double-clicking its icon or selecting it and 
choosing the Open Document command from the File Menu.

If no other documents are open, double-clicking on a document icon opens the document in Text View 
and double-clicking a thumbnail opens the document in Image View. If a document viewing window is 
open, the new document comes up in the same view as the last one if you have set Browse Documents 
in the Options menu. 

It takes PageKeeper longer to display an Image View than a Text View because it is decompressing the 
super-compressed image. 

You can resize the document window by clicking and dragging on its borders. 

The number of documents you can have open simultaneously in PageKeeper depends on your system 
configuration.

Related Topics

Changing the Image Size

Moving Between Pages

Window Colors in Text View

Opening and Viewing External Files



Ñ Window Colors in Text View

In Text View, you can view white text on a blue background by selecting the White on Blue option from 
the Text View Colors command in the Options menu. Windows that are already open do not change 
from your default system colors, but all subsequent text windows will open in White on Blue until you 
deselect this option.

Related Topics

Changing the Image Size

Moving Between Pages

Opening and Viewing External Files



Ñ Moving Between Pages

The number of pages in a document is indicated in the title bar with a "Page x of y" display. You can use 
the scroll bar to move through a document page. The scroll bar will only take you to the bottom of a 
page; you must use the page commands in the Document menu to move through a multi-page 
document.

Click the Next Page and Previous Page buttons or choose First Page, Previous Page, Next Page, and 
Last Page from the Document menu to move through the document. The Go to Page... command lets 
you specify a particular page to display.

Related Topics

Changing the Image Size

Window Colors in Text View

Opening and Viewing External Files



Ñ Changing the Image Size

In Image View, you can use the Zoom-In and Zoom-Out tools to change the size of the entire page or to 
focus on a particular part of the image.

To zoom in:

1. Select the Zoom-In Tool icon or its command in the Document menu.

2. Move the Zoom-In cursor over the part of the image you want to enlarge. 

3. Click the left mouse button.

4. You can continue clicking until you have zoomed in to the highest level. Make another selection to 
deselect this tool.

To zoom out:

1. Select the Zoom-Out Tool icon or its command in the Document menu.

2. Move the Zoom-Out cursor over the part of the image you want to reduce. 

3. Click the left mouse button.

4. You can continue clicking until you have zoomed out to the lowest level. Make another selection 
to deselect this tool.

Related Topics

Moving Between Pages

Opening an Viewing External Files



Ñ Opening and Viewing External Files

When you search an external index, external documents that appear along with database documents in 
your results list. External files are files located on your local or remote drives outside the database. They 
are identifiable by their pathname in the results list and they have a different icon than database 
documents. 

You can view external files in text view in the same way that you view a database document. They can 
be copied from, but they cannot be saved to folders, annotated or mailed. When you select Image View 
for an external file, PageKeeper launches the host application if it's available.

Related Topics

Changing the Image Size

Moving Between Pages

Window Colors in Text View



Ñ Launching the Host Application

When you open an external file in image view, PageKeeper launches the host application if there is a 
word-processing or text editing application associated with the file. If an application isn't associated with 
the file, you can choose Associate... from the File menu of the Windows File Manager to create an 
association. See your Windows documentation for more information.

Related Topics

Copying Information from Documents



Ñ Copying Information from Documents

You can copy both text and images from documents and paste them into a new file in a different 
application. You can also copy text into PageKeeper document notes. Use the Copy feature to combine 
information from several PageKeeper documents into a single new file, or to copy scanned information 
in PageKeeper into other types of files on your computer.

You are using the Windows clipboard when you use the Copy command. So, after you have copied the 
region you want, you'll find that the Paste command is active when you open another Windows 
application.

With the Image View displayed, you can copy a whole image or just a zoomed portion of it. 

Related Topics

Copying an image

Copying Text

Suggested Uses for this Feature



Ñ Copying an image

1. Use the Zoom-In Tool or the Zoom-Out Tool from the Document menu (or their buttons in the 
button box) to bring the image or portion of the image that you are copying to the size you want to 
copy.

2. Choose the image Selection Tool option from the Document menu or select its icon from the 
Button box.

3. Click and drag the cross-hatch until a selection box encompasses the image you want. 

4. Choose Copy from the Edit menu.

5. Open the file where you want to place the region and choose Paste from the application's File 
menu.

Related Topics

Copying Text



Ñ Copying Text

1. Highlight the text you want to copy to the clipboard.

2. Choose Copy from the Edit menu.

3. Open the file where you want to place the text and choose Paste from the application's File menu.

Related Topics

Copying an image



Ñ Suggested Uses for this Feature

You can combine the text in one document with the image in another to save yourself time and increase 
the impact of your documents. You might, for example, create a clip file of company photos from your 
company newsletter that you could borrow from when creating departmental communications.

Related Topics

Copying an image

Copying Text



Ñ Adding Notes

You can highlight important information and organize your own ideas by adding notes that stay with a 
database document when it is saved or sent to someone else. Notes can be inserted anywhere in the 
document and can be attached to a document in both text and image view.

Related Topics

Creating Notes

Notes Are Indexed

Opening and Deleting Notes

Uses for this Feature



Ñ Notes Are Indexed

The text of the notes is automatically indexed. To include notes in a search, you just select Annotations 
from the choice of indexes. In some cases you may want to use notes to add synonyms to key terms 
found in a document so that the document would be found by a search for that term. 

Annotations do not display separately in a search results list; the document associated with the 
annotation displays in the results window.

You may also want to create notes for documents containing little or no text. For example, you could 
annotate a spreadsheet named po391 with a list of terms such as Purchase Orders, March, and 1991, 
or describe the contents of a graphics file that has no text.

Related Topics

Creating Notes

Opening and Deleting Notes



Ñ Creating Notes

To create a note in an open document:

1. Select Create Note from the Document menu or double-click the cursor on the open document. (If 
you are in Image View and have used the selection or zoom tools, you have to deselect the tool 
from the Document menu before the cursor is available.)

A push-pin button appears at the top of the document window and a yellow note window opens 
over the document. 

2. Type directly into the yellow note window. The note's title bar shows the name of the document 
you are annotating and the page number the note is located on. 

You can also copy text into a note from the clipboard.

3. Save the note by selecting Save Note from the Notes menu.

4. Close the note by clicking the control menu at the top left of the note window. 

 The number of notes you can create is limited only by available memory and disk space. When you 
reach the limit for the number of push-pin buttons that fit at the top of the document window, scroll 
buttons appear. 

Related Topics

Notes Are Indexed

Opening and Deleting Notes



Ñ Opening and Deleting Notes

Every user of the database can read, edit, and delete notes. If you are sharing a database you may 
want to establish a policy for deleting notes.

At creation, every note is given a push-pin button at the top of the document window. Click a push-pin 
button to open a note. The button is depressed while the note is open.

When you are in Image View, any notes that were created by double-clicking on the image appear as 
push-pin buttons at the location you specified.

If the note window is buried by the document window, you can bring the note window forward by single-
clicking the depressed push-pin button.

To close the note window, click the control menu at the top left of the note window.

Selecting Browse Notes from the Options menu automatically closes an open note when a new note is 
opened.

Delete an open note by selecting Delete Note from the Notes menu or deleting its contents and closing 
it.

Related Topics

Creating Notes

Notes Are Indexed



Ñ Suggested Uses for this Feature

You can use notes to make comments about the document before sending it to a co-worker or just to 
remind yourself of an important point the next time you open this document.

You can also create hypertext-like link between documents through annotations. For example, if you had 
a database of potential articles, you could annotate the ones you definitely wanted to print in the fall 
journal with the words publish and October.

Related Topics

Creating Notes

Notes Are Indexed

Opening and Deleting Notes



Ñ Printing

You can print both text and image versions of documents. Use the Print Setup... command in the File 
menu to specify the type of printer you are using. 

To print a document:

1. Highlight or open the document you want to print.

2. Choose Print... from the File menu.

The Print dialog box displays.

3. Fill in the Print Range, Print (Text, Text and Notes, Notes Only, or Image), and the Print Quality 
fields, and click OK. 

This is information about this specific print job. Click Setup... to display the Print Setup dialog box.

If the Text and Notes and Notes Only options in the Print field are grayed, there are no notes associated 
with the selected document.

Select Print Setup... from the File menu to change the settings in the Print Setup dialog box, such as the 
printer to use and options associated with it.

Select Page Layout... from the File menu to specify the margins of pages.

Related Topics

Printing Images

Printing Annotations



Ñ Printing Images

Document images are printed by page, and every new page starts at the top of a page. If an image is 
too long to print on one page, the remainder of that page will be finished on the next page and then a 
new page will be started for the next new page. Thus the printout may include a full page, a short page, 
a full page, etc. For example, this could happen if you scanned in a 14 inch image, but selected 8 1/2 x 
11 inches for your printing paper size.

Related Topics

Printing Annotations



Ñ Printing Annotations

You can print the notes that are attached to database documents in the same way that you print a 
document. Select the Text and Notes or the Notes Only option in the Print field of the Print dialog box 
and select the range of pages you want to print. When you select a range of document pages with the 
Text and Notes option, the document pages print and then the notes attached to those pages print on a 
separate page or pages. If you choose to print the entire document, the notes are printed after the 
document is printed.

To print a single note without a document page, simply select Print... from the File menu while the note 
window is active. Most of your options in the Print dialog box will be grayed, but you can select the 
Notes Only option and the number of copies of the selected note you want to print. You cannot print a 
range of pages for notes when a note window is active.

Related Topics

Printing Images



Ñ Exporting Documents

You can export a text file to an external file in a number of different text formats. You can export an 
image to an external file in TIFF or PCX format.

This allows you to use images scanned into PageKeeper in other applications. You can also combine 
documents or parts of them by exporting them to another application.

When you export a multi-page image file in TIFF format, PageKeeper creates one file per image page 
and gives each file a unique name.

Related Topics

Exporting a File

Supported File Formats

Uses for this Feature



Ñ Exporting a File

1. Select the file to be exported.

2. Choose Export to File... from the File menu.

The Save As dialog box displays.

3. Name the file, choose the directory location, and choose the new format from the Save File As 
Type list. This list displays numerous file formats including TIFF, compressed TIFF, PCX, 
WordPerfect for Windows, Lotus .WK1, and Word for Windows. Scroll through the list until you 
find the format you want to use.

4. When you have filled in the box, click OK.

Related Topics

Supported File Formats



Ñ Suggested Uses for this Feature

After circulating a contract and annotating sections that you would like to have reworded, you could 
export it to another application for those changes.

Related Topics

Exporting a File

Supported File Formats



à Customizing Your Tools--Quick Start

To customize your window:

· Turn menu commands into easy-to-use buttons in the button box by pressing down the Ctrl key, 
selecting the menu command you want, positioning the icon pointer over the button box and 
clicking the mouse button. 

· Change the appearance of the button box by selecting Wide, Narrow, or Hidden from the button 
box command in the Options menu.

· Choose which windows open when you first open your PageKeeper database by choosing 
Folders, Post Office, or Mailbox from the Auto-Open command in the Options Menu.

· Choose the appearance of document text by selecting White on Blue or System Colors from the 
Text View Colors command of the Options menu.

Related Topics

Adding Commands to the Button Box

Changing the Size of the Button Box

Changing the Document Text

Changing the Initial Windows Display



à Adding Commands to the Button Box

The button box is a set of command buttons that displays across the top of the PageKeeper window. 
You can perform a menu command by simply clicking a button. 

You can add new buttons and delete existing buttons in the button box so that you have easy access to 
the commands you use most often. 

Your customized button box is saved for you when you exit, and will open automatically the next time 
you use PageKeeper.

See Task Icons for a list of PageKeeper commands and associated icons in the default button box. See 
your PageKeeper Owner's Manual for a complete list of commands and associated buttons.

Related Topics

Adding a new button to the Button Box

Changing the Document Text

Changing the Initial Windows Display

Changing the Size of the Button Box

Task Icons



à Adding a new button to the Button Box

1. Press down the Ctrl key, then select the command you want from one of the menus with the 
mouse pointer.

When you release the left mouse button, you'll see that the standard mouse pointer has been 
replaced by a button pointer that looks like a miniaturized menu. 

2. Position the button pointer in the button box and click the mouse button again to drop the menu 
command button onto the nearest grid location.

3. Repeat these steps until every command that you want has been made a button.

To remove one of the buttons from the button box, Ctrl-click it with the right mouse button. (The four big 
buttons in the Wide button box cannot be removed.)

To move buttons between grid locations, Ctrl-drag the button with the left mouse button.

Related Topics

Task Icons



à Uses for this Feature

If you frequently add notes to documents, you could add the Create Note button to the button box.

If you often batch your scanning jobs, you could add the Recognize/Edit Scanned Docs... button to the 
button box.

If you are not sharing a database, you could remove the Mailbox button from your button box.

On any particular day, if you are using one function repeatedly, you can add that function to your button 
box and then remove it before exiting PageKeeper. For example, if you are exporting a lot of information 
out, you would find it very helpful to add the Export to File... button to the button box. When you've 
finished exporting, however, you may find other buttons more useful.



à Changing the Size of the Button Box

You can change the size of the button box or hide it completely with the button box commands in 
Options menu. 

Use the Wide option to display a two-level bar with some wide buttons for easy viewing and lots of room 
for adding buttons. 

Use the Narrow option to display a single row of buttons. 

Note that buttons installed at the end of a display in super VGA may be hidden (and inaccessible) in 
lower resolutions.

Use the Hidden option to remove the display of the button box from the PageKeeper window. 

You can switch back and forth between these options at any time. Your button box selection is saved for 
you when you exit, and will automatically open in the same way the next time you open the database.

Related Topics

Adding Commands to the Button Box

Changing the Document Text

Changing the Initial Windows Display



à Changing the Document Text

You can change the appearance of a document's text in the Text View window with the Text View Colors 
command in the Options menu.

Choose White on Blue to display white text on a blue background.

Choose System Colors to display the text and background colors used by your system.

When you change the colors of the document viewing window, all subsequent document windows that 
you open will have the same appearance until you change your selection. Windows that were open prior 
to a change are not affected until you perform an action in that window.

Related Topics

Adding Commands to the Button Box

Changing the Size of the Button Box

Changing the Initial Windows Display



à Changing the Initial Windows Display

You can customize the way the button box and windows display when you open a PageKeeper 
database so that you have immediate access to the windows and commands you use most frequently.

Select Auto-Open from the Options menu to have any of these windows open automatically when 
PageKeeper starts:

¨ Folders window

¨ Post Office window

¨ Mailbox window

Your selection for the button box options (Wide, Narrow, Hidden) in the Options menu determine how 
the button box appears the next time you open the database.

Note that the buttons in the Folders and Mailbox buttons change in the Wide button box when those 
windows are open.

The icons in the Scan and Weighted Word Search buttons change while those processes are active.

Related Topics

Adding Commands to the Button Box

Changing the Size of the Button Box

Changing the Document Text



à Menu Options

File menu

Edit Menu

Folders Menu

Document Menu

Notes Menu

Search Menu

Results Menu

Mail Menu

Admin Menu

Options Menu

Window Menu

Help Menu



à File menu

New Database... creates a new PageKeeper 
database.

Open Database... opens a PageKeeper database.

Close Database closes a PageKeeper database.

Open Document opens the currently selected 
document.

Close Active Window closes the window with the 
highlighted title bar.

Import from File... imports an existing computer file into 
the database according to the 
options you specify.

Export to File... saves a document to a local or 
network file in the format you 
specify.

Recognize/Edit 
Scanned Docs...

opens partially processed 
documents that you batched so that 
you can control recognition and/or 
editing before the import is finished.

Finish Unattended 
OCR/Indexing

automatically finishes recognition 
(without zoning or editing) and 
indexing that you deferred.

Scan... scans documents into the database 
according to the options you specify.

Quick Scan scans documents using the last 
Scan settings specified without 
displaying the Scan dialog box.

Scan Setup... displays the Select Scanner dialog 
box where you specify the type of 
scanner you are using. You may 
also have to provide information 
about the Port Address and Speed 
of your scanner. 

Print... prints the currently selected or 
displayed document and notes.

Page Layout... displays the Page Layout dialog box 
so that you can specify aspects of 
the final page layout such as 



margins.

Print Setup... displays the Print Setup dialog box 
where you can specify the type of 
printer you are using, the page 
orientation and other options.

Exit exits PageKeeper.

Related Topics

Creating a New Database

Exporting Documents

Finishing Batch Processing

Index in Batch Mode

Opening and Viewing Database Documents

Printing

Scan in Batch Mode

Supported Scanners



à Edit Menu

Cut removes the current selection and 
places it on the clipboard.

Copy copies the current selection to the 
clipboard.

Paste pastes the current clipboard 
contents at the cursor location.

Delete deletes the current selection.

Related Topics

Edit/Verify Text

Using the Editing Tools



à Folders Menu

Create Folder... creates a new folder.

Edit Name... edits the name of a document or 
folder.

Move... moves folders or documents from 
one folder to another.

Copy... copies documents into another 
folder or to the top level of the 
window hierarchy.

Delete deletes the current selection.

Expand/Collapse toggles the current folder open or 
closed to show/hide the next level of 
folders and documents.

Expand Branch shows all folders and documents in 
the current folder.

Collapse Branch hides all folders and documents in 
the current folder.

Expand All opens all folders to show every 
document in the database.

Collapse All displays only the top level of folders 
(and documents) in the database.

Related Topics

Organizing the Database

Opening and Viewing Database Documents



à Document Menu

First Page displays the first page of document.

Previous Page displays the previous sequential 
page of document.

Next Page displays the next sequential page of 
document.

Last Page displays the last page of the 
document.

Go to Page... goes to the page number you 
specify.

Text View displays the document text.

Image View displays the original scanned 
version of the file (if available).

Go to Search Word locates the occurrences of search 
words in a document.

Previous Search 
Word

finds the previous occurrence of a 
search word in a document.

Zoom-In Tool selects and deselects a tool for 
enlarging the bitmap image of a 
document.

Zoom-Out Tool selects and deselects a tool for 
reducing the bitmap image of a 
document. 

Selection Tool selects and deselects the tool for 
specifying a section of the bitmap for 
copying to the clipboard.

Create Note opens a note window.

Related Topics

Opening and Viewing Database Documents

PageKeeper Windows

Searching Made Relevant--Quick Start



à Notes Menu

Save Note saves the active note.

Delete Note deletes the active note.

Go to Search Word locates the occurrences of search 
words in a note.

Find Next  locates the occurrences of search 
words in a note.

Find Previous finds the previous occurrence of a 
search word in a note.

Related Topics

Adding Notes



à Search Menu

Weighted Word 
Search...

searches for a word or words and 
returns documents in order of 
relevance to your query.

Weighted Boolean 
Search...

searches for a group of words that 
meet the conditions you specify and 
returns documents in order of 
relevance to your query. 

Document Agent 
Search...

uses analysis of a document's 
content to find other documents with 
similar content and displays a 
content pathways diagram and a 
results list of the documents ordered 
by relevance to your query.

Related Topics

Saving Search Results

Selecting a Search Method

Using the Document Agent Search

Using the Weighted Boolean Search

Using the Weighted Word Search

What Gets Searched



à Results Menu

Sort by Name sorts the search results 
alphabetically by file name.

Sort by Relevance sorts the search results by the 
relevance to the search topic. (This 
is the default behavior.)

Create Results 
Folder

saves the search results 
(alphabetically) in a folder.

Make Agent 
Document

graphs the contents of a selected 
results document using only the 
current Document Agent Search 
results list, not the entire database.

Prev Agent 
Document

returns the content pathways 
diagram to its appearance with the 
last agent document used in the 
current Document Agent Search 
window.

Related Topics

Saving Search Results

Selecting a Search Method

Using the Document Agent Search

What Gets Searched



à Mail Menu

Read Message 
Text...

displays the Message Text dialog 
box.

Delete Mail removes a message and file from 
the Mailbox.

Related Topics

Using Mail



à Admin Menu

Many Admin functions are only available to the Admin user of the database.

Delete Users... allows the Admin user to change the 
list of users who can access a 
database.

Locate File Index... finds and connects you to existing 
local or remote PageKeeper 
indexes.

(Re-)Index Files... updates an external file index. All 
users can re-index their hard drives, 
only the Admin user can re-index a 
network directory.

Re-Index Database allows the Admin user to update the 
PageKeeper database index and 
expunge files associated with 
deleted documents.

Recondition 
Database

optimizes database files.

Related Topics

PageKeeper Indexes

Maintaining the System



à Options Menu

Browse Documents replaces the contents of a document 
window with new contents rather 
than opening a new window.

Browse Notes replaces the contents of a note 
window with new contents rather 
than opening a new window.

One Search at a 
Time

closes the previous search results 
window when you start a new 
search.

Auto-Open Folders opens the Folders window 
automatically when PageKeeper 
starts.

Auto-Open/Post 
Office

opens the Post Office window 
automatically when PageKeeper 
starts.

Auto-Open/Mailbox opens the Mailbox window 
automatically when PageKeeper 
starts.

Button Box/Wide displays the wide version of the 
button box.

Button Box/Narrow displays a one-line button box.

Button Box/Hidden removes the button box display.

Text View 
Colors/White on Blue

uses white text on a blue 
background for document text 
display.

Text View 
Colors/System 
Colors

 uses your system colors for 
document text display. (This is the 
default.)

Beep for New Mail beeps when a new message is 
received.

Related Topics

Adding Commands to the Button Box

Changing the Document Text

Changing the Initial Windows Display

Changing the Size of the Button Box

Opening and Viewing Database Documents



PageKeeper Windows

Using Mail



à Window Menu

Show Folders/Hide 
Folders

changes the current display of the 
Folders window.

Show Post 
Office/Hide Post 
Office

changes the current display of the 
Post Office window. (Open this 
window to send files to other users.)

Show Mailbox/Hide 
Mailbox

changes the current display of the 
Mailbox window. (Open this window 
to receive files and messages from 
other users.)

Cascade displays all open windows in 
standard Windows Cascade format.

Tile displays all open windows in 
standard Windows Tile format.

Arrange Icons aligns all buttons along the lower 
edge of the desktop.

Close All closes all windows.

Related Topics

Using Mail

Changing the Initial Windows Display

PageKeeper Windows



à Help Menu

Contents displays a list of topics available in 
the Help program. Double-click a 
topic to display help information 
about the current window or 
procedure.

Search for Help On... displays a dialog box where you can 
enter a specific topic that you need 
more information about.

Commands displays a list of all commands and 
descriptions.

Procedures displays instructions for all 
procedures.

Keyboard displays a list of keyboard shortcuts.

Index displays an alphabetical list of topics 
in Help.

How to Use Help displays information about how to 
use Help.

About... displays the current software version 
you are using and any copyrights in 
effect.



\ ScanningQuick Start

If you are scanning a page or pages:

· Choose Set Recognition Zones to select which zones you want recognized and in what order.

· Choose Edit/Verify Text to check and change the spelling or content of OCR'd text.

· Choose Scan in Batch Mode to have recognition and/or editing delayed until you choose the 
Recognize/Edit Scanned Docs... or Finish Unattended OCR/Indexing command.

· Choose Index in Batch Mode to delay indexing until you choose the Finish Unattended 
OCR/Indexing command.

· Use the Pages box to select multiple page options if you are scanning in multiple pages or 
documents.

· Choose the Language... button for recognition of characters unique to a particular language.

· Choose the Options... button to select page orientation and control brightness settings. You can 
also select a specific reject character and activate Auto Spelling Assist.

Related Topics

Set Recognition Zones

Edit/Verify Text

Scan in Batch Mode

Index in Batch Mode

Finishing Batch Processing

Page Options

Language...

Options...



\ Importing an ImageQuick Start

If you are importing an image file:

· Choose Set Recognition Zones to select which zones you want recognized and in what order.

· Choose Edit/Verify Text to check and change the spelling or content of OCR'd text.

· Choose Scan in Batch Mode to have recognition and/or editing delayed until you choose the 
Recognize/Edit Scanned Docs... or Finish Unattended OCR/Indexing command.

· Choose Index in Batch Mode to delay indexing until you choose the Finish Unattended 
OCR/Indexing command.

· Choose the Language... button for recognition of characters unique to a particular language.

· Choose the Options... button to select page orientation and a specific reject character and to 
activate Auto Spelling Assist.

Related Topics

Set Recognition Zones

Edit/Verify Text

Scan in Batch Mode

Index in Batch Mode

Finishing Batch Processing

Page Options

Language...

Options...



\ Importing a Text FileQuick Start

If you are importing a text-only file:

· The Set Recognition Zones option will not be available.

· Choose Edit/Verify Text to check and change the spelling or content of the text you are importing.

· Choose Scan in Batch Mode to have any editing (specified with Edit/Verify Text) delayed until you 
choose the Recognize/Edit Scanned Docs... command.

· Choose Index in Batch Mode to delay indexing until you choose the Finish Unattended 
OCR/Indexing command.

· Choose the Options... button to activate Auto Spelling Assist.

Related Topics

Set Recognition Zones

Edit/Verify Text

Scan in Batch Mode

Index in Batch Mode

Finishing Batch Processing

Page Options

Language...

Options...



\ Specifying Settings

The dialog box that opens when you select Scan... or Import File... from the File menu is very similar in 
appearance except that the Scan dialog box includes a Page Options box. 

If you are importing an image file, you will have many of the same options available that you have when 
scanning a document. If you are importing a text-only file, you'll have fewer options. 

Set Recognition Zones

Edit/Verify Text

Scan in Batch Mode

Index in Batch Mode

Finishing Batch Processing

Page Options

Language...

Options...

Orientation

System

Document

Brightness



\ Set Recognition Zones

PageKeeper can recognize standard magazine column layouts, tables, and standard single column 
layouts automatically. Use the Set Recognition Zones option when you want to:

· select only a part of the page for recognition

· when the column layout is so complicated (broken up with sidebars, etc.) that you want to 
manually select the order of the recognition zones.

If this option is turned off, the whole page is recognized. Data compression is slower when you set the 
recognition zones manually. 

If you choose Set Recognition Zones, the window with the Recognition tools displays. After PageKeeper 
scans your page or imports the image, you can draw selection boxes around specific parts of the page 
that you want recognized. 

When you are done selecting regions, click Recognize to start the recognition process. After recognition 
of each page, the compression process begins.

Related Topics

Document Processing Options

Edit/Verify Text

Finishing Batch Processing

Index in Batch Mode

Scan in Batch Mode

Using Recognition Tools



\ Edit/Verify Text

Select Edit/Verify Text to display the file in the verification and editing window. This allows you to edit 
imported files and/or correct any recognition errors for image files before indexing and saving in the 
database. You can also copy, delete, and rearrange sections of the document.

Use this window to

· Edit the displayed text with the Cut, Copy, Paste and Delete commands in the Edit menu.

· See a scanned image of a word by double-clicking it. The original scanned image displays in the 
Verification Window.

· Choose Auto Spelling from the Edit menu so that PageKeeper automatically corrects common 
recognition errors. It will display the number of changes made. 

· Access the Check Spelling command in the Edit menu to open the Check Spelling tool for 
interactive spell-checking with suggested replacement words. 

· Access the Find/Replace command in the Edit menu to open the Find/Replace tool for editing the 
document. 

· Move between pages on a multiple page document by clicking the page icon at the bottom of the 
screen. 

When you are done editing, select Finish Import from the File menu. If you select this command without 
saving, PageKeeper will prompt you to save changes made to the file.

Related Topics

Document Processing Options

Finishing Batch Processing

Index in Batch Mode

Scan in Batch Mode

Set Recognition Zones

Using Recognition Tools

Using the Editing Tools



\ Scan in Batch Mode

Select Scan in Batch Mode when you want to do only the initial scanning or importing and you want to 
postpone any recognition and/or editing processes. 

This allows you to scan a number of pages in automatically and then recognize and edit them as a 
group at your convenience.

If you chose Set Recognition Zones or Edit/Verify Text along with Scan in Batch Mode, you should select 
Recognize/Edit Scanned Docs... from the PageKeeper File menu to finish the recognition and editing.

If you chose Scan in Batch Mode without selecting Set Recognition Zones or Edit/Verify Text, any optical 
character recognition (OCR) is postponed, but it will be done automatically without input from you. You 
should select Finish Unattended OCR/Indexing from the PageKeeper File menu to finish the recognition 
process. Note that automatic recognition is batched with indexing, which is also automatic.

Document Processing Options

Edit/Verify Text

Finishing Batch Processing

Index in Batch Mode

Set Recognition Zones

Using Recognition Tools

Using the Editing Tools



\ Index in Batch Mode

Select Index in Batch Mode when you want to separate document processing from the indexing 
process. This means that indexing is delayed until you choose the Finish Unattended OCR/Indexing 
command from the File menu. 

The jobs that you batched that require automatic recognition and indexing are processed as a group in 
the order that they were batched.

Indexing is always an automatic process and it is the last step in the process of adding a document to 
the database. Recognition is automatic (and unattended) if you chose Scan in Batch Mode without 
selecting Set Recognition Zones or Edit/Verify Text.

Document Processing Options

Edit/Verify Text

Finishing Batch Processing

Scan in Batch Mode

Set Recognition Zones

Using Recognition Tools

Using the Editing Tools



\ Finishing Batch Processing

You resume processing of batched documents by selecting Recognize/Edit Scanned Docs... and/or 
Finish Unattended OCR/Indexing from the File menu. The documents are processed in the order that 
they were batched.

Only the user who batched the documents can finish importing those batched jobs.

If you cancel the operation while batched jobs are being processed, any of the documents in the group 
that were completed are saved in their new state. A document in the midst of being processed reverts 
back to its previous state and is grouped with the other incompletely processed documents for later 
reselection. 

Document Processing Options

Edit/Verify Text

Index in Batch Mode

Scan in Batch Mode

Set Recognition Zones

Using Recognition Tools

Using the Editing Tools



Page Options

When you are scanning a document, the Page Options list box in the Scan... dialog box gives you 
different page entry options.

· Single

Use this for scanning single page documents. 

· Multiple

Use this to scan multiple pages as a single document with an automatic document feeder (ADF). 
PageKeeper will ask if you want to scan more pages for the current document.

· Multiple, Double Sided

Use this when you are scanning pages of a document with print on both sides with an ADF. After you 
scan one side of the stack, PageKeeper will prompt you to flip the stack to scan the pages on the 
reverse side. 

· Multiple, Blank Separators

Use this to scan a number of one-sided documents at a time with an ADF. Pages that follow a blank 
page are saved with a new document name. Insert blank pages as separators in the locations that you 
want before setting the stack in the ADF.

Related Topics

Set Recognition Zones

Edit/Verify Text

Scan in Batch Mode



\ Language...

Click on Language... to choose one or more languages for text recognition. A dialog box will display a 
list of available languages.

PageKeeper will recognize additional characters (such as circumflexes and umlauts) unique to a 
particular language. You can select more than one language by clicking multiple selections; for faster 
recognition, however, use only the minimum number you need.

If you choose a foreign language, you should not use Auto Spelling Assist unless you have a foreign 
language dictionary.

Related Topics

Auto Spelling Assist



\ Options...

Click Options... to display the Options dialog box with additional information such as paper size, page 
orientation method, and brigthness. Manually adjusting the brightness setting may speed up page 
recognition. 

The options that are available depend on what kind of document you are adding to the database. When 
you are importing a text-only file, only the Auto Spelling Assist System option is applicable.

Related Topics

Brightness

Document

Orientation

System



\ Orientation

The Orientation section lets you specify the orientation of the document you are scanning or image you 
are importing. The icon will change to reflect the orientation chosen. Select Portrait for long pages such 
as a business letter; select Landscape for wide pages such as a spreadsheet. 

When scanning landscape-oriented pages, be sure that you load them into your scanner correctly. 

Related Topics

Brightness

Document

System



\ System

The System section lets you specify the character used when PageKeeper cannot recognize a 
character, and whether you want automatic spelling correction.

Related Topics

Auto Spelling Assist

Brightness

Document

Orientation

Reject Character



\ Reject Character

The Reject Character edit box lets you choose a character to mark unrecognized characters in your text. 
The tilde (~) is the default reject character. For example, if PageKeeper could not recognize the J in 
REJECT when scanning an image, and the tilde was the reject character, the string RE~ECT would 
appear in your text file. After recognition, any characters replaced with the reject character are 
highlighted in red. Words or characters that PAGEKEEPER is unsure it recognized correctly are 
highlighted in green.

Related Topics

Auto Spelling Assist



\ Auto Spelling Assist

Select Auto Spelling Assist to have PageKeeper automatically correct spelling errors caused by 
problems with recognition. After recognition, the Auto Spelling dialog opens and starts the spelling 
verification. Click Accept to accept the changed spellings. If you click Cancel during spelling verification, 
the process will be canceled but your document will still be imported. The Auto Spelling dialog shows 
you how many words were corrected and those words are highlighted in blue in the text. Unknown 
words are highlighted in green.

You can also use Auto Spelling Assist when you are importing text-only files.

Related Topics

Reject Character



\ Document

This box lets you specify the kind of document being scanned or imported to improve the accuracy of 
the OCR. 

Related Topics

Page Layout

Auto

No Parsing

Single Column/Tables

Paper Size



\ Page Layout

Page layout modes specify how blocks of text on the page will be ordered for recognition. You can only 
select Paper Size if you are scanning or importing an image.

If you select Auto for the Page Layout, PageKeeper divides a page into a series of text blocks and strips 
out graphics. For example, if two vertical text blocks are separated by white space (gutters), 
PageKeeper recognizes two separate columns of text blocks and orders text in the file accordingly. The 
left column will appear first in your file and then the right column. This works well for many documents, 
but there are times that you may want to select No Parsing or Single Column/Tables.

Related Topics

Auto

No Parsing

Paper Size

Single Column/Tables



\ Auto

Select Auto if you want PageKeeper to determine column structure automatically. With this setting, 
PageKeeper looks for regular vertical separations of text to define columns. It then recognizes column-
wide text blocks. It starts at the top of the first column, moves to the bottom, and then continues to the 
top of the next column. The resulting text file displays the text in one column from beginning to end.

Do not use Auto for tables and financial forms. Although those types of document have multiple 
columns, this will destroy their spreadsheet format. Use Single Column/Tables for these types of 
document.

Likewise, you may want to use Single Column/Tables for standard office memos (with their To and From 
columns) and correspondence, which has a single column layout. 

Related Topics

No Parsing

Page Layout

Paper Size

Single Column/Tables



\ No Parsing

Select No Parsing if you are scanning pages with very small text, such as telephone book pages, that 
might appear as graphics to PageKeeper. You should also use No Parsing if you are scanning very 
small or narrow regions.

PageKeeper recognizes the entire document as a single text block. It does not divide the text into 
separate text blocks or strip out graphics. If there are graphics on the page, PageKeeper will attempt to 
recognize them as text elements.

Related Topics

Auto

Page Layout

Paper Size

Single Column/Tables



\ Single Column/Tables

Select Single Column/Tables when there is one column on a page, as with correspondence, or when 
scanning a table, financial form, or spreadsheet.

PageKeeper treats the entire page as one column. It starts at the top of the page and moves to the 
bottom, outlining page-wide text blocks. If PageKeeper detects five or more spaces between columns, it 
assumes that the document is a spreadsheet. It will insert tabs as delimiters between the columns to 
preserve the tabular format.

Related Topics

Auto

No Parsing

Page Layout

Paper Size



\ Paper Size

The Paper Size list box lets you select the dimensions of the document you are scanning. You can only 
select Paper Size if you are scanning a new document. 

You have these choices:

¨ Letter 8 1/2 x 11 in for standard US size pages.

¨ Legal 8 1/2 x 14 in for US legal size pages.

¨ A4 for 210 x 297 mm European-size pages.

Related Topics

Auto

No Parsing

Page Layout

Single Column/Tables



\ Brightness

The Brightness setting is the most important means you have to affect the accuracy of text recognition. 
It works like the brightness setting on a copier and helps you deal with differences in paper and print 
quality. By adjusting brightness, you can ensure the highest accuracy of text recognition with all kinds of 
documents by lightening or darkening a scanned image.

Related Topics

Auto Intensity

Evaluating Brightness Settings

Manual Intensity



\ Auto Intensity

Select Auto Intensity to let PageKeeper set up an optimal brightness setting automatically by using 
Caere AnyPage or HP AccuPage technology. This feature is available with some HP and Microtek 
scanners.

This feature is especially useful when you scan text printed on a colored background. It also works well 
when you scan copies of copies that have large gray areas. Scanning is faster, however, with this option 
turned off. If you scan high-quality documents with crisp, black letters printed on non-reflective white 
paper, use Manual Intensity instead of Auto Intensity.

Related Topics

Evaluating Brightness Settings

Manual Intensity



\ Manual Intensity

To adjust the Brightness control manually, select Manual Intensity, click the pointer with the mouse. Drag 
the pointer to the desired level, click the arrows to move the level up and down, or type a new value in 
the box. Use the number in the box as a reference for future documents. If you find that a particular 
brightness setting is effective with a certain quality of document, use that setting the next time you scan. 
Intensity levels are always whole numbers; the number of intensity levels you have depends on the 
make of your scanner.

Related Topics

Auto Intensity

Evaluating Brightness Settings



\ Evaluating Brightness Settings

If a page has sharp, distinct characters printed on good-quality non-reflective paper, set the brightness 
setting in the middle range.

If a page has thin, broken characters, darken the brightness setting by moving the pointer to the right or 
increasing the value in the box.

If a page has thick, run-together characters or if it is printed on porous paper such as newsprint, or 
glossy paper such as magazines, lighten the brightness setting by moving the pointer to the left or 
decreasing the value in the box.

To evaluate brightness settings, watch the Character Window during text recognition. If the brightness 
setting is incorrect, you may want to select Cancel and rescan with a different setting. 

Related Topics

Auto Intensity

Manual Intensity



\ Using the Recognition Tools

You can specify how a document is recognized with the tools that display on the left side of the Import 
Document window during the Set Recognition Zones process.

The tools let you select and order zones and zoom the view in or out. The buttons on the button bar let 
you start and cancel the recognition process, rotate the page, and adjust the regions to be recognized 
after the process has started.

Related Topics

Adjust

Draw Zones

Erase Zones

Order Zones

Recognize

Rotation arrows

Zoom Out/Zoom In



Zoom Out/Zoom In

If you want a close-up view of an area, click the Zoom-In tool and then click the area of the page you 
want enlarged. 

Click the Zoom-Out tool and then click the area to zoom out to a wider view.

The levels of zoom are Fit in Window, 25%, 50%, and 100%. The 100% view gives you a pixel-for-pixel 
view of the scanned image. If you want to zoom all the way in or out, hold down the Ctrl key while you 
click a zone with a Zoom tool.

Related Topics

Adjust

Draw Zones

Erase Zones

Order Zones

Recognize

Rotation arrows



Draw Zones

Click the Draw Zones tool and then enclose each area you want recognized with a selection box by 
holding the mouse button down and dragging the mouse. Zones will be recognized in the order you 
select them unless you use the Order zones tool (the # symbol). Areas that are not selected will not be 
included in the text version of the document.

A number appears in each zone indicating the order in which the zone will be recognized. You may draw 
up to 99 separate zones. 

Once you have drawn a zone, you can adjust its size. First, click the zone to select it. Handles will 
appear on the edge of the selection box. Click the mouse on a handle and drag it to the desired size. To 
move the entire zone, move the pointer inside the zone, hold down the mouse button, and move the 
mouse.

If you are scanning multiple pages, the zoning you used for the previous page comes up as the default 
for a new page. You can move, erase or reorder these zones with the appropriate tools.

Related Topics

Adjust

Erase Zones

Order Zones

Recognize

Rotation arrows

Zoom Out/Zoom In



Order Zones

Normally, zones are recognized in the order you select them. To change the order in which the zones 
will be recognized, click the Order Zones tool. The numbers in the zones will disappear.

To reorder the zones, click the zone you want recognized first. The number 1 will appear in the zone. 
Then click in the next zone you want recognized; the number 2 will display. Continue until the zones are 
ordered correctly.

Related Topics

Adjust

Draw Zones

Erase Zones

Recognize

Rotation arrows

Zoom Out/Zoom In



Erase Zones

If you want to deselect a zone, click the Erase Zones tool and then click the zone to deselect. The 
contents of the zone will not be deleted, but the selection box will be removed and the zone will not be 
recognized.

Related Topics

Adjust

Draw Zones

Order Zones

Recognize

Rotation arrows

Zoom Out/Zoom In



\ Rotation arrows

Three arrows display in the toolbar. You can click these arrows to flip your document if it was put in the 
scanner incorrectly. You do not need to replace the page in the scanner; PageKeeper will recognize the 
text if it appears correctly oriented in the window. 

 Click on this arrow to flip the page 90° counter-clockwise.

 Click on this arrow to flip the page 180°.

 Click on this arrow to flip the page 90° clockwise.

Related Topics

Adjust

Draw Zones

Erase Zones

Order Zones

Recognize

Zoom Out/Zoom In



\ Adjust

Click the Adjust button if you did not select the correct regions for OCR. For example, if you notice that 
you did not select every region on a page that you want to recognize, you can click Adjust, select the 
additional region, and click Recognize again. PageKeeper will recognize all the selected regions.

Related Topics

Draw Zones

Erase Zones

Order Zones

Recognize

Rotation arrows

Zoom Out/Zoom In



\ Recognize

When you have selected the regions to your satisfaction, click Recognize to start the recognition 
process. To cancel recognition, click Cancel. A character window displays a sample of the text as it is 
being OCR'd. If the text is too dark or too light, and you want you want to change your Brightness 
setting, you can click Cancel and scan it again.

Related Topics

Adjust

Draw Zones

Erase Zones

Order Zones

Rotation arrows

Zoom Out/Zoom In



\ Using the Editing Tools

The menu options that display in the Import Document window during the Edit/Verify Text process 
include the Auto Spelling..., Check Spelling, Options and Find/Replace editing tools and the Style menu 
options.

See the topic Edit/Verify Text for a discussion of the basic menu functions.

Related Topics

Auto Spelling

Check Spelling

Find/Replace

Style Menu



\ Auto Spelling

To correct recognition errors:

1. Select the Spelling Setup... command in the edit window'sFile menu. You can select one main 
and one user dictionary from the lists that display. 

2. Select any of the spelling options that you want.

Select Ignore ALL CAPS to skip any words of four letters or less that are capitalized (for example, 
IBM, or NOW.)

Select Ignore Proper Nouns to skip any capitalized word not appearing at the beginning of a 
sentence (for example, Her new product name is called Artemian). Words that are spelled with a 
captial in the middle (for example, PageKeeper) are considered run-on words and are separated 
until they are added to the user dictionary during Check Spelling.

Select Ignore Abbreviations to skip any word consisting of a capitalized letter followed by three or 
fewer lower-case letters and a period (for example, Mrs., Aug.).

Select Phonetic Suggestions to have the Check Spelling Suggestions box list replacement words 
based on phonetic possibilities as well as OCR errors. For example, if PageKeeper encounters 
the word coarn, it may suggest Koran or corner as well as corn.

3. Select Auto Spelling... from the edit window's Edit menu.

4. Auto Spelling dialog opens.

7. Open the Check Spelling tool from the Edit menu to locate changed or unknown words. 

Related Topics

Check Spelling

Find/Replace

Style Menu



\ Check Spelling

The Check Spelling tool opens when you select Check Spelling from the Edit menu. You can use this 
interactive spell-checking tool independently or as a backup to Auto Spelling.

Text following the cursor is checked when you select the Check button. When Check Spelling finds a 
misspelled, unknown, or auto-changed word, that word is highlighted in the text file, the OK and Add 
buttons become active, and suggested replacement words may appear in the tool's Suggestions list 
box. 

If the text is from a scanned document or image file, the Verification Window shows you the image of the 
questioned word so that you can check it before selecting a replacement. You can add a questioned 
spelling to the user dictionary with the Add button or add it to a temporary dictionary for the document 
with the OK button.

Related Topics

Add

Auto Spelling

Check

Find/Replace

OK

Style Menu

Suggestions



\ Check

Clicking Check starts or continues the spell-checking process. If an unfamiliar or misspelled word is 
highlighted and you click Check, Check Spelling ignores the word and finds the next misspelled word.

Related Topics

Auto Spelling

Check Spelling

Find/Replace

Style Menu



\ OK

Clicking OK adds the misspelled (or highlighted) word to a temporary dictionary. PageKeeper ignores 
future instances of the word and will go on to find the next misspelled word.

The temporary dictionary is active until you close the document or change dictionaries.

Related Topics

Auto Spelling

Check Spelling

Find/Replace

Style Menu



\ Add

Clicking Add adds the    highlighted word to your permanent user dictionary. Check Spelling ignores 
future instances of the word and will go on to find the next unfamiliar or misspelled word.

Words added to the user dictionary will be recognized as acceptable spellings in future documents. To 
add a word to the user dictionary, type it into the document, highlight it, and choose Check so that the 
Add button is available. Then click Add.

Related Topics

Auto Spelling

Check Spelling

Find/Replace

Style Menu



\ Suggestions

Clicking a word in the Suggestions list box replaces the highlighted word in the text with the word in the 
edit box.The word as it appears in the text is the default option.

Related Topics

Auto Spelling

Check Spelling

Find/Replace

Style Menu



\ Find/Replace

Select Find/Replace to show or remove the Find/Replace tool below the menu bar.

Related Topics

Auto Spelling

Check Spelling

Find and Replace Options

Finding and Verifying Words

Replacing Words

Style Menu



\ Finding and Verifying Words

To find a word or set of characters, type the word or characters in the Find edit box. Then click the Find 
button. With scanned or imported images, the Verification Window will display the image of the 
requested word. To search for the next instance, click Find again.



\ Replacing Words

To replace a word or set of characters with another word, type the word to search for in the Find edit box 
and the word to replace it with in the Replace edit box. Click Find to locate the first occurrence of the 
word. Then you can click Replace to replace it.

To change the next occurrence of the word, click Replace again. To replace all occurrences of a word, 
click Replace All. If you choose Find after Replace from the Options selection box, you can click 
Replace Selection to have the tool replace all following occurrences of the word without finding them for 
you first.



\ Options

The Options selection box in the Find/Replace tool provides different ways to find and replace words. 

· Match Case

To be found, a word must exactly match the upper- and lower-case attributes of the word in the Find edit 
box.

· Whole Word

To be found, a word must match, in length, the word in the Find edit box. Compound words that contain 
the searched-for word within them will not be found.

· Find Backwards

The search will progress backwards from the location of the text cursor to the beginning of the 
document.

· Wrap Around

After reaching the end of a document, the search will continue from the beginning of the document to 
the location of the text cursor.

· Find after Replace

After a found word is replaced, the next instance of the word in the Find edit box will be searched.



\ Style Menu

The Style menu options are available so that you can make the character style of the scanned text 
match the original document. The changes that you make with this menu are saved with the document 
and will be visible when you export it to another application. Style changes are not visible in the 
database document viewer.

When you have highlighted a word or words, you have the following options in the Style menu:

¨ Regular

¨ Bold

¨ Italic 

¨ Underline



Supported Scanners

Scanner Driver Version Interface ScanMgr

A

Abaton DTP Scan 4 PSCAN.SYS 1.10 EV-2208 SCMGR01.EX
E

Abaton Scan 300/FB, 300SF SCN8.COM Revision 
E

ISI-8 SCMGR02.EX
E

Abaton Scan 300S, 300GS ABASCAN.SYS 2.01 EV-8114 SCMGR01.EX
E

Abaton Transcribe/300 TRANSCRB.SYS 1.0 EV-3114 SCMGR01.EX
E

Agfa Focus I, II, and Color None ASC-88 SCMGR12.EX
E

Apple OneScanner ASPI2DOS.SYS AHA-1510 SCMGR07.EX
E

AVR 3000 AVRTC.SYS 1.05 TIGerCUB SCMGR08.EX
E

B

Brother BS300 USCAN.SYS 4.22 USE-TB Rev B SCMGR04.EX
E

Brother BS300G USCAN.SYS 4.22 GS11-PC SCMGR04.EX
E

C

Canon IX-12, IX-12F IXHND2.COM 1.04 IF-3 SCMGR05.EX
E

Canon IX-30F SI3.SYS 1.21 GIX-IF (AZDSI-30) SCMGR31.EX
E

Complete Flatbed Scanner CPCFSCAN.SYS 1.11 Flatbed Scanner 
Interface

SCMGR08.EX
E

Complete Page Scanner CPCSCAN.SYS 2.10 Scanner Interface 
Board

SCMGR13.EX
E

D

DataCopy GS Plus XIS380GS.SYS 1.20 Model 1201 SCSI 
Adapter

SCMGR07.EX
E

DEST PC Scan SCANDRVR.SYS 3.0 DEST PC Interface SCMGR07.EX
E

DEST Scan 2000, Scan 3000 SCANDRVR.SYS 3.0 DEST PC Interface SCMGR07.EX
E

E

Epson ES-300C EPSN300C.PXW NA B808011 SCMGR07.EX
E

F

Fora IMG-311, IMG-321, 
IMG-511

USCAN.SYS 4.22 USE-TB Rev B, 
GS11-PC

SCMGR04.EX
E

Fujitsu 309X w/Dunord 
interface

I2000.EXE 1.03 I-2000 SCMGR55.EX
E

Fujitsu 309X w/Kofax interface KF9X00.EXE 1.20 KF-9200 SCMGR07.EX
E



Fujitsu 3096G w/Adaptec 
interface

ASPI4DOS.SYS 2.10 AHA-1542 SCMGR07.EX
E

G, H

Howtek Personal Color 
Scanner

None Kofax KF-9200 SCMGR07.EX
E

HP ScanJet, ScanJet Plus SJDRIVER.SYS 3.10 88290A, 88490A SCMGR08.EX
E

HP ScanJet IIc SJII.SYS 1.39 C1752A SCMGR42.EX
E

HP ScanJet IIp SJII.SYS 1.39 C1752A SCMGR42.EX
E

I

IBM 3119 None SCMGR07.EX
E

J, K

Kyocera A-800 SCNDRV.SYS 1.16 KS-800 SCMGR33.EX
E

L

Lightspeed 320F, 300G USCAN.SYS 4.22 USE-TB Rev B, 
GS11-PC

SCMGR04.EX
E

M

Mectel UF32/UF42, UG80 USCAN.SYS 4.22 USE-TB Rev B, 
GS11-PC

SCMGR04.EX
E

Microtek MS-300A MSCAN.SYS 2.73 MS-PCE SCMGR09.EX
E

Microtek MS-300C MSCAN.SYS 2.73 MS-PCX SCMGR09.EX
E

Microtek MS-II MSCAN.SYS 2.73 MS-PCX SCMGR11.EX
E

Microtek MSF-300G, 
MSF-400G

MSCAN.SYS 2.73 MS-PCY SCMGR09.EX
E

Microtek MSF-300Q, 
MSF-300Z

MSCAN.SYS 2.73 MS-PCY SCMGR09.EX
E

Microtek ScanMaker 600G, 
600Z

MSCAN.SYS 2.73 MS-PCY SCMGR09.EX
E

Microtek ScanMaker 600Z 
w/ADF

MSCAN.SYS 2.73 MS-PCY SCMGR09a.E
XE

N, O, P

Panasonic FX-RS307, FX-
RS506

MEISCAN7.COM 4.0 FX-BS181 SCMGR10.EX
E

Q, R

Ricoh IS30-M2, RS312 SCN8.COM Revision 
E

ISI-8 SCMGR02.EX
E

Ricoh RS320, RS322, RS322+ SCN8.COM Revision 
E

ISI-8 SCMGR02.EX
E

Ricoh IS60 (parallel) SCN8.COM Revision 
E

ISI-8 SCMGR02.EX
E

Ricoh IS50, IS60 (SCSI) Interface 
dependent

various SCMGR07.EX
E

S

Sharp JX-300 GPIB.DLL 2.1.1 Nat'l Instr. GPIB- SCMGR07.EX



GPIB.INI PCII E
Siig Sirius32, 32GS USCAN.SYS 4.22 USE-TB Rev B, 

GS11-PC
SCMGR04.EX
E

T,U

Umax UF32/UF42, UG80 USCAN.SYS 4.22 USE-TB Rev B, 
GS11-PC

SCMGR04.EX
E

V

Visa FBS300/FBS400,GS300 USCAN.SYS 4.22 USE-TB Rev B, 
GS11-PC

SCMGR04.EX
E

W

Wang SC300 SCN8.COM Revision 
E

ISI-8 SCMGR02.EX
E

X, Y, Z



Before You Begin Troubleshooting 

Your first step in troubleshooting any problem should be to verify that your computer, network, and other 
applications are functioning properly. Windows 3.1, your network software, and your scanner's image 
scanning software should be installed and working properly before you install PageKeeper. If you have a 
problem with PageKeeper functions, check to make sure that other Windows applications are working 
properly. If you have problems scanning a document, try scanning the document with the software that 
came with your scanner. If you have problems communicating with other users or files on your network, 
check with your network administrator. Resolve any problems that occur with Windows 3.1, your 
network, or your image scanning software before you try using PageKeeper again.



Transaction File Problems

Ñ All users sharing data must have read/write access to the same network transaction file. 
Explanation



To create or open a database on the network, you must have a network transaction file. It is very 
important that all users sharing data use the same transaction file. If you are creating a database, make 
sure that all users have read/write access to the transaction file you select. If you are opening an 
existing database, check with the Admin user or your network administrator to determine the file you 
should use.

See the Release Notes and Changing the Transaction File for more information.



Installation and Setup Problems

An installation problem is often the result of an improper or incompatible system configuration. 
Sometimes, installation problems occur because of a bad diskette or corrupted file. This section details 
the most common installation problems and solutions.

Ñ SETUP repeatedly requests the same disk. Explanation

Ñ Could not open the file name SCANNER.DLL. It is in use by another application. Explanation

Ñ An autoexec.bat file does not exist on the root directory of your boot drive. Explanation



Locate your config.sys file and comment out the line:
DEVICE= ... TRANSCRB.SYS ... 

by typing an asterisk in front of it. Then run the setup program again.



If the correct disk is in the disk drive, the disk is probably damaged. To check the disk, exit the 
installation program and open the MS-DOS prompt window. Type dir a: at the DOS prompt. If you 
receive an error message from DOS, the disk is damaged.

If you are able to see the disk directory, try to copy a file from the disk to your hard disk. DOS may be 
unable to copy files from the disk even if it can read the directory.

If the disk is damaged, contact Technical Support for a replacement.



The PageKeeper setup program looks for your autoexec.bat file on the C drive. Be sure an autoexec.bat 
file exists in C:\.



Scanning Problems

Ñ PageKeeper hangs the system at the beginning of the recognition process. Explanation

Ñ The scanner begins to scan and stops. The system hangs and you must reboot to use your 
computer. Explanation

Ñ You manually set zones for recognition, but the text was not recognized.Explanation

Ñ You see vertical lines running through the document image or no image at all when you attempt 
to set zones or while watching the OCR. You receive garbage or nothing when you attempt text 
recognition. Explanation

Related Topics

Scanning Performance ProblemsScanningPerformanceProblems.182
Improving Recognition Accuracy
Importing Problems



This can happen when you have selected small zones and PageKeeper mistakes the text for a graphic. 
When setting small zones, use the Options... button in the Scan dialog box to select No Parsing as the 
Page Layout mode. Then scan the document again so that PageKeeper will recognize the contents of 
the zone as text elements.



Many computer systems provide a feature called shadow RAM to enhance system performance. If 
PageKeeper causes the system to hang, turn off the shadow RAM function of your computer and try 
again. See your computer's operations manual for information on disabling shadow RAM.

Some computer systems do not allow you to turn shadow RAM off. Incompatibilities with these systems 
are usually not related to shadow RAM.

System hangs may be related to incompatibilities with memory-resident applications or device drivers. 
Use a text editor to comment out any memory-resident device drivers and applications from your 
autoexec.bat and config.sys file not used by Windows 3.1, PageKeeper, your scanner, or your hard 
drive and reboot your system.

Warning: Do not remove a device driver unless you are aware of its function and know that it may be 
safely removed. Hard disks often require special device drivers that should not be removed. Video 
displays that require special device drivers may need to be reconfigured instead of removed. Make a 
boot disk with your current operating system version, autoexec.bat, and config.sys to guard against 
potential mistakes.



You may have an interrupt conflict between your scanner and another device. If you have a bus mouse 
and you usually do not use the mouse and scanner at the same time, check the interrupt used by the 
scanner and mouse for a possible conflict. The interrupt address typically used by some network cards 
may cause the same problem. 

You see vertical lines running through the document image or no image at all when you attempt to set 
zones or while watching the OCR. You receive garbage or nothing when you attempt text recognition.



The memory address for your scanner interface card is probably interfering with the memory address for 
your video display adaptor. Use the instructions in your scanner owner's manual to move the scanner 
interface card to a different memory address.



Scanning Performance Problems

You can improve the speed and quality of scanned documents by changing your options in the Scan 
dialog box. See DocumentProcessing Options for more information about these settings.

Quality of Recognition
Scanning Speed
Document Type
Document Layout



Quality of Recognition

PageKeeper determines optimal brightness for accurate text recognition when the Auto Intensity option 
is selected in the Scan dialog box. Scanning is faster, however, with this option turned off.

Related Topics

Scanning Speed
Document Type
Document Layout



Scanning Speed

You can increase your scanning speed by turning off the    Auto Intensity option and setting the Manual 
Intensity level. This may be helpful if you are scanning documents of very high quality. If the document 
quality is poor or uneven, however, you will probably want to use the Auto Intensity option.

Related Topics

Quality of Recognition
Document Type
Document Layout



Document Type

Recognition quality is affected if you do not choose the correct document type. Select Fully Formed 
when you scan conventionally printed text characters. Select Standard Fax for standard mode faxes and 
low-resolution images (200 x 100 dpi). 

Related Topics

Quality of Recognition
Scanning Speed
Document Layout



Document Layout

To preserve the page layout of correspondence and tables, choose the Single Columns/Tables option 
available from the Scan settings dialog box. Use this when there is a single column on a page, as with a 
business letter, office memo, table, financial form, or spreadsheet.

Related Topics

Quality of Recognition

Scanning Speed

Document Type

Document Processing Options



Improving Recognition Accuracy

If you scan typeset, high-quality printed pages, you will probably find that PageKeeper recognizes text 
perfectly: the text that appears in your imported document matches the text in the scanned page letter-
for-letter.

With lesser-quality pages, text-recognition will be not be as accurate. The following factors most affect 
text-recognition accuracy:

Document Quality
Brightness Setting
Scanner Glass Clarity
Paper Transparency



Document Quality

PageKeeper recognizes characters in almost any font from 6 to 72 points in size. Keep the following 
points in mind however, as they influence accuracy:

* The print should be reasonably clean and crisp. Characters must be distinct: separated from each 
other and not blotched together or run-on.

* The document should be free of notes, lines, or doodles; anything that is not a printed character 
will slow recognition, and any character distorted by a mark will be unrecognizable.

* The document font must be non-stylized; for example the Zapf Chancery font is too fancy for 
PageKeeper.

* Underlined text is difficult to recognize accurately; the underline changes the shape of 
descenders on the letters g, j, p, q, and y.

Related Topics

Brightness Setting
Scanner Glass Clarity
Paper Transparency



Brightness Setting

The Brightness setting is the most powerful means to improve text-recognition accuracy. Adjust this 
option from Scan dialog box to improve recognition. 

Related Topics

Document Quality
Scanner Glass Clarity
Paper Transparency



Scanner Glass Clarity

The sheet of glass on the flatbed of the scanner must be clear. If it gets dirty, wipe it gently with a soft, 
damp, lint-free cloth or tissue. Be sure that it is completely dry before you put pages on it.

Related Topics

Document Quality
Brightness Setting
Paper Transparency



Paper Transparency

Some paper, such as telephone book pages, is thin enough that the scanner reads text printed on the 
reverse side of a scanned page. To correct this problem, put a black piece of paper between the page 
being scanned and the scanner lid.

Related Topics

Document Quality
Brightness Setting
Scanner Glass Clarity



Importing Problems

You get unexpected results (garbage) from an imported file. Try importing the file again with the AUTO 
selection in the List Files of Type field.



Performance Problems

Ñ PageKeeper works, but operates slowly and frequently accesses the hard disk drive. 
Explanation

Ñ Document viewing process is slow. Explanation

Ñ You get unexpected results after printing a document. Explanation

Ñ Style changes you made are not visible. Explanation



As a Windows 3.1 application, PageKeeper is able to take advantage of the Windows swap file when 
running low on memory. This may occur with a minimally configured system (4MB RAM), if memory has 
become fragmented with use or if other applications are running in the background. When low memory 
conditions occur, Windows will use disk space to simulate the RAM it does not have available. Disk 
access time is much longer than RAM access time; the computer system will run much slower when it 
has to use a swap file.

Try closing any other background applications that are running. This should generally free enough 
memory for PageKeeper to operate without using the swap file.

If you regularly work with long, complex documents or need to have many documents open at a time, 
adding more RAM to your system is the best solution.

For information on optimizing your system and application performance under Windows 3.1, see your 
Windows user's guide.



Images take longer to display than recognized text because PageKeeper is decompressing the super-
compressed image.



Printing may produce garbage if the scanner and printer have different dpi measures.



You made and saved style changes to the text in the edit window with the Style menu, but those 
changes are not visible in the database document viewer. The changes are saved with the document, 
however, and will be visible when you export the document to another application.



Error Messages A - E

Ñ An error has occurred locating the external index path. Explanation

Ñ An error has occurred; no external indexing was performed. Explanation

Ñ An error has occurred. The printing has been cancelled. Explanation

Ñ Another Admin user may be currently re-indexing the database. Only one Admin user can re-
index the database at a time. Explanation

Ñ Boolean entries are empty. Please enter the desired words for the search. Explanation

Ñ Boolean expression not satisfied. Explanation

Ñ Brightness Manual Intensity entry must be a whole number in the range of <upper limit> to 
<lower limit>. Explanation

Ñ End of text reached. Explanation



Enter at least two words for the Weighted Boolean Search, one on each side of the AND operator.



The path you selected was not valid or the index does not exist.



Call Technical Support.



There may be a hardware problem with your printer. 



None of the documents in the indexes you selected satisfied the conditions of your Weighted Boolean 
Search. You can change or expand your Boolean expression or try using the same words in a Weighted 
Word Search.



Fill in the field with a whole number (e.g., 2 not 2.5) in the range specified. The number of intensity 
levels available depend on the make of your scanner.



If you want to continue viewing the search words within this document or note, step through the search 
hits in the opposite direction with either Go to Search Word (Tab key is the shortcut) or Previous Search 
Word (Shift+Tab is the shortcut).



Error Messages F - M

Ñ Failed to export document. Explanation

Ñ Failed to import the word-processor file. Explanation

Ñ Failure loading the printer's device driver. Explanation

Ñ Folders cannot be copied. Please try again. Explanation

Ñ Hardware Port Address entry must be a valid integer. Explanation

Ñ Hardware Speed entry must be a valid integer. Explanation

Ñ Index entries are empty. Please select the indexes to search and try again. Explanation

Ñ Insufficient buffer length. Explanation

Ñ Insufficient disk space on database drive. Please free up some disk space and try again. 
Explanation

Ñ Insufficient disk space on destination drive. Please free up some disk space and try again. 
Explanation

Ñ Insufficient disk space on TEMP drive. Please free up some disk space and try again. 
Explanation

Ñ Mail transaction was not successful. Explanation



Important database files may have been deleted or you may be out of disk space in the target location.



There may have been a problem in the format translation or you may be out of disk space in the target 
location.



Check your printer setup in the Windows Control Panel.



Your scanner setup requires that this field be filled in.



You can move a folder or rename it, but you cannot copy a folder.



Your scanner setup requires that this field be filled in.



Click at least one of the selection boxes for the Indexes to identify the source of your search.



Call Technical Support.



Try again. If the problem persists, check the transaction file. See Setting Up the Transaction File in 
Chapter 2 of the Owner's Manual.



Error Messages N - N

Ñ No application is associated with this file. Choose File/Associate from the Windows File 
Manager to create an association. Explanation

Ñ No batched jobs to process at this time. Explanation

Ñ No default printer was found. Explanation

Ñ No document image to export.    Document has no associated image. Explanation

Ñ No document is selected. Please select a document and try again. Explanation

Ñ No external index exists for this path. Explanation

Ñ No folder name has been specified. Please try again. Explanation

Ñ No message for this transaction. Explanation

Ñ No pages found between the blank separators. Please check the scanner and try again. 
Explanation

Ñ No parent folder name has been specified.    Please try again. Explanation

Ñ No printer device drivers were found. Explanation

Ñ No similar documents found. Explanation

Ñ No user is currently selected. Please fill in the User Name box to continue. Explanation

Ñ No visible transaction is highlighted. Explanation



The command you selected will not be carried out because there are no batched jobs in the queue.



Check your printer setup in the Windows Control Panel.



You may be trying to save an imported text file as an image.



The operation that you requested requires that you select a document first. You can select a document 
by highlighting its icon in any list.



Select a different path, use the Locate Index... command.



You must fill in this field or cancel the dialog box.



There was no mail text sent with this message.



You must fill in this field or cancel the dialog box.



Check your print drivers setup in the Windows Control Panel.



The database does not contain other documents with similar content pathways.



If this is the first time you've used this database, you can type your name directly into the User Name 
field, otherwise you should be able to select your name from the list box.



You must scroll the selected mail message back into view.



Error Messages O - O

Ñ One or more files were not added to the index. Explanation

Ñ Only files on the fixed drive are to be indexed. Explanation

Ñ Only files on the remote drive are to be indexed. Explanation

Ñ Only the Admin user can index network files. Explanation

Ñ Only the database Admin user is allowed to use this command. Explanation



When indexing a local or network drive, PageKeeper identified one or more files that appeared suitable, 
but could not be indexed.



Only the Admin user has the authority to index remote drives. If you are logged in as Admin, you may 
have selected a remote drive after specifying that you were indexing a local drive.



You may have selected a local drive after specifying that you were indexing a remote drive.



You must be logged in as Admin to index a network file.



Error Messages Pa - Pa

Ñ PageKeeper cannot find the file given on the command line: filename Explanation

Ñ PageKeeper cannot locate the transaction file. Explanation

Ñ PageKeeper cannot recognize the command line option option-name. Explanation

Ñ PageKeeper could not create an external index. Explanation

Ñ PageKeeper does not recognize this file as the type you specified. Do you want to continue? 
Explanation

Ñ PageKeeper is unable to add a folder to the database. Explanation

Ñ PageKeeper is unable to change the name in the database. Explanation

Ñ PageKeeper is unable to create a button box. Explanation

Ñ PageKeeper is unable to create a note window. Explanation

Ñ PageKeeper is unable to create a window. Explanation

Ñ PageKeeper is unable to create the database 'database name'. Explanation

Ñ PageKeeper is unable to create the push-pin bar. Explanation

Ñ PageKeeper is unable to delete the note because another user has changed it. Explanation

Ñ PageKeeper is unable to display the login dialog box. Explanation

Ñ PageKeeper is unable to initialize itself. Explanation

Ñ PageKeeper is unable to open the database 'database name'. Explanation

Ñ PageKeeper is unable to perform that deletion. Explanation

Ñ PageKeeper is unable to perform that move operation. Explanation

Ñ Page number entry must be between 1 and page-number.Explanation



Your page number entry was outside the range of the page numbers for the document. Try again with a 
number from one to the indicated limit



PageKeeper cannot find the file specified. This file is supposed to be a database, so PageKeeper will 
not open it.



Check that your PageKeeper transaction file is set up correctly. See Setting Up the Transaction File in 
Chapter 2 of the Owner's Manual. If you are running PageKeeper on a Novell network, it's possible that 
the Btrieve NLM isn't set up correctly.



PageKeeper does not currently recognize any command line options other than the name of a file.



You are out of disk space in that location or you don't have write access to that location on the network.



Select Yes to continue the import with the file type you specified. Select No to cancel the import. In most 
cases, continuing the operation does not produce a usable document; the exception is with ASCII files. 
If you know the file is ASCII text you'll generally get good results when you force the import with one of 
the ASCII options.



There may be a problem with the transaction file. See Setting Up the Transaction File in Chapter 2 of 
the Owner's Manual.

It's possible that you are out of memory, see the instructions for the error The supply of free memory is 
very low. There might also be problems with the disk or database. If the problem persists, call Technical 
Support.



There may be a problem with the transaction file See Setting Up the Transaction File in Chapter 2 of the 
Owner's Manual. If you are sharing a database, two people may have tried to change the name at the 
same time. Try again.



Close open windows within PageKeeper. If the problem persists, see the instructions for the error The 
supply of free memory is very low.



The push-pin bar may be full. You may want to consolidate notes or delete outdated ones.



If you are trying to open a document when you get this message, close other open documents. (The 
number of open documents you can have open simultaneously depends on your system configuration.) 

If the problem persists, see the instructions for the error The supply of free memory is very low.



You are out of disk space in that location or you don't have write access to that location on the network.



The document may have too many notes for the resolution of your monitor. This generally happens 
when a database user with a high-resolution monitor attaches notes to the very end of the push-pin bar. 
To fix the problem, go to a system with a high-resolution monitor so that you can open the document. 
Consolidate notes by cutting and pasting so that you can reduce the number of push-pin buttons in the 
push-pin bar and make the document accessible on your system. 

It's also possible that you have memory problems, see the instructions for the error The supply of free 
memory is very low.



You may want to establish policies with other users of the database about the deletion of notes.



There is a problem reading the database.



See the instructions for the error The supply of free memory is very low.



Files in the database directory may have been deleted or corrupted.



You may have tried to delete the default folder, the ShoeBox. The ShoeBox can be renamed, but it 
cannot be deleted.

Another possibility is a problem with the transaction file. See Chapter 2 of the Owner's Manual, Setting 
Up the Transaction File. There could also be memory problems, see the instructions for the error The 
supply of free memory is very low. You could also have a disk problem. If the problem persists, call 
Technical Support.



Call Technical Support.



Error Messages Pl - Pz

Ñ Please select a single folder to which PageKeeper can paste. Explanation

Ñ Please select the item(s) you want PageKeeper to move. Explanation

Ñ Printer not found. Explanation

Ñ Problems determining the page layout. Explanation

Ñ Problems loading data into OCR. Explanation

Ñ Problems preparing document for export.      Database may be corrupted. Explanation

Ñ Problems preparing document for index processing. Explanation

Ñ Problems preparing document for index processing. Explanation

Ñ Problems reading data from scanner. Explanation

Ñ Problems receiving data from the zone editor. Explanation

Ñ Problems recognizing data. Explanation

Ñ Problems searching.      Memory may be low, or the database may be corrupted. Explanation

Ñ Problems super-compressing the page image. Explanation

Ñ Problems when OCR attempted page decomposition. Explanation

Ñ Problems with document index processing, another user my be accessing the index. 
Explanation

Ñ Problems with document post-edit processing. Explanation

Ñ Problems writing batched job to disk. Explanation



There are problems writing the super-compressed image to disk. Check that you have write permission 
and that there is enough space on the drive where the database is located.



See the instructions for the error The supply of free memory is very low.



Check your printer setup in the Windows Control Panel.



Try using a different page layout mode in the Options settings of your Scan dialog box and rescan the 
page. For example, try Single Columns/Tables instead of AUTO. See Chapter 8, Document Processing 
Options in the Owner's Manual for more information. If the problem persists, try changing the brightness 
setting.



Report the problem to Technical Support.



Database files may have been deleted or corrupted. Call Technical Support.



Database files may have been deleted or corrupted. Call Technical Support.



Check your scanner setup. If you were able to use your scanner very recently, you may have a memory 
problem. See the instructions for the error The supply of free memory is very low.



This page caused recognition problems, try rescanning it. If you did not set recognition zones the first 
time, you might try creating two half-page zones with the Set Recognition Zones option.



Another user of the database may be indexing or re-indexing files or saving an annotation. Try again. If 
the problem persists, see the instructions for the error The supply of free memory is very low.



There was a problem with HP AccuPage decomposition.



If you are on a shared database, you will have to wait until the index is available before you execute this 
operation. You may want to set a policy that large indexing jobs are done after normal business hours. If 
you are not sharing a database, call Technical Support.



Check that you have write permission and that there is enough space on the drive where the database 
is located.



There are problems writing the batched job to the database. You may be out of disk space on that drive. 
Call Technical Support.



Error Messages R - S

Ñ Reject Character field must not be empty. Explanation

Ñ Removable drives cannot be indexed. Explanation

Ñ Search found only external files. A results folder will not be created. Explanation

Ñ Search found some external files. The external files will not be copied to the results folder. 
Explanation

Ñ Selected item is not a document. Please select a document and try again. Explanation

Ñ Sorry, somebody has edited this note since you opened it. Should PageKeeper try to create a 
new note containing your text?Explanation

Ñ Sorry, the last copy of document 'document-name' has been deleted from the database.    
PageKeeper will close viewer window for that document. Explanation

Ñ Specified word(s) not found. Explanation



Someone may have modified or deleted the note you were working with. If you select Yes the note will 
be saved, if you select No it will be discarded. Selecting Cancel returns you to the window the way it 
was.



You must fill in this field or cancel the dialog box.



You cannot index a floppy drive or any removable drive such as Bernoulli box, magneto-optical, WORM, 
or CD-ROM.



You cannot copy external files within PageKeeper. 



You cannot copy external files within PageKeeper. Your results folder will only contain the database 
documents from the results list.



The operation that you attempted can only be performed on a document. You can select a document by 
highlighting its icon in any list.



Another user deleted the last database copy of a document while it was open on your machine. 
PageKeeper issued the warning and then was forced to close the document viewer on the machine. You 
may want to establish guidelines with other users of the database. See Sharing a Database in Chapter 3 
of the Owner's Manual for more information.



The search word(s) do not exist in the indexes you selected for searching or they are noise words that 
are so common in the English language (and generally not useful) that they are not searched by 
PageKeeper. See How Hyphenations Are Handled for treatment of hyphenated words and Noise Words 
for the list of excluded words.



Error Messages T - T

Ñ That name is not unique.      Please try again. Explanation

Ñ The current user was not deleted. Explanation

Ñ The database 'database name' already exists. Explanation

Ñ The database could not be initialized.      PageKeeper will exit. Explanation

Ñ The index data may not be consistent with the file data. Explanation

Ñ The menu items that list the open windows cannot be made into buttons. Explanation

Ñ The move or copy operation you attempted is not allowed. Explanation

Ñ The note was not successfully deleted. Explanation

Ñ The supply of free memory is very low. Explanation

Ñ The User Table cannot be updated. Explanation

Ñ There has been a problem saving your note.      If you would like to save the note text, save it in 
the clipboard. Explanation

Ñ There is no image information for this page. Explanation

Ñ There is no such folder. Explanation

Ñ There is no such parent folder. Explanation

Ñ There should be more pages to scan on this side of the stack. (This replaces Need to scan 
more bottom pages) Explanation

Ñ This application requires enhanced mode.      Restart Windows with the command "win /3". 
Explanation

Ñ This note does not contain any text. Explanation

Ñ This note has been deleted by another user. No note window will show. Explanation

Ñ This path was already used for the local external index.    Please select a different path for your 
network external index. Explanation

Ñ This path was already used for the local external index. Please select a different path for your 
network external index. Explanation

Ñ This path was already used for the network external index.    Please select a different path for 
your local external index. Explanation

Ñ This path was already used for the network external index. Please select a different path for 
your local external index. Explanation

Ñ Too many documents are selected.    Please select only one document and try again. 
Explanation



Folders and documents must have unique names and a folder may not have the same name as a 
document.



There were problems updating the database tables.



Check that your PageKeeper transaction file is set up correctly. See Setting Up the Transaction File in 
Chapter 2 of the Owner's Manual. If you are running PageKeeper on a Novell network, it's possible that 
the NLM isn't set up correctly.



Rename the database and try again.



The files may have changed since the local or network external files were last indexed. You may want to 
choose a time to re-index these files.



Some items in the PageKeeper database cannot be moved or copied. For example, folders cannot be 
copied, the ShoeBox cannot be moved, and a folder cannot be moved into a sub-folder of itself.



The number list at the bottom of the Window menu tells you which menus are open within PageKeeper 
and lets you change the active window. These menu items do have icons associated with them and 
cannot be made into buttons



Close down other applications in the system, you have too many things running simultaneously. If the 
problem persists, the next step is to close PageKeeper and then start it again so that the operating 
system will free up memory. If that doesn't solve the problem, exit Windows and reboot your system.



One of the database tables is corrupted. Call Technical Support.



PageKeeper was unable to save your note. After you copy it to the clipboard, you can paste it in a new 
note.



Make sure that the folder name you have specified is correct. Selecting the folder in the Folders window 
will accurately enter its name into this field.



Make sure that the folder name you have specified is correct. Selecting the folder in the Folders window 
will accurately enter its name into this field.



See your Windows user's manual for more information about running Windows in enhanced mode.



The index file names must be unique.



The index file names must be unique.



The operation that you requested requires that you select only one document first. Single-click a 
document or its icon to select it (and deselect any others).



Error Messages U - Z

Ñ Unable to automatically recognize file type. Explanation

Ñ Unable to back up the database index.    Please free up some disk space on the database drive 
and try again. Explanation

Ñ Unable to completely add a new document entry. Explanation

Ñ Unable to create a new document entry. Explanation

Ñ Unable to initialize the decompression. Explanation

Ñ Unable to initialize the OCR.    To free up available memory, exit PageKeeper and Windows and 
reboot your system. Explanation

Ñ Unable to initialize the printer. Explanation

Ñ Unable to reindex the documents in the database. Explanation

Ñ Unable to reindex the notes in the database. Explanation

Ñ Unable to retrieve the document for printing. Explanation

Ñ Unable to retrieve the note for printing. Explanation

Ñ Unable to set up the image for reading. Explanation

Ñ Unable to start reindexing the database. Explanation

Ñ Unable to start scanner. Check that proper scanner selection was made. Explanation

Ñ Unable to set up OCR. Explanation

Ñ Unable to set up the scanner. Explanation

Ñ Unable to start batch processing. Explanation

Ñ You cannot attach a note to an external file. Explanation

Ñ You must select the individuals you want to include in the group mailing before placing 
documents in the Group mailbox. Explanation



You may be able to force the translation of a text file (e.g., a file that you know is an ASCII file), but you 
may get unexpected results. Do not try to force the translation of an image file, save the file and call 
Technical Support.



PageKeeper backs up the index before re-indexing. Free up enough disk space on the database drive 
for this backup copy and then try re-indexing again.



Check that you have enough space on your target location and that you have write permission to the 
transaction file. See Setting Up the Transaction File in Chapter 2 of the Owner's Manual.



Check that you have write permission to the transaction file. See Setting Up the Transaction File in 
Chapter 2 of the Owner's Manual.



See the instructions for the error The supply of free memory is very low.



If you are running PageKeeper with 4MB RAM and have not used its OCR function, you cannot switch 
to another application and then return to PageKeeper to use its OCR function without rebooting. To 
access the contiguous memory block needed for OCR, you must exit PageKeeper, quit Windows, and 
then re-open PageKeeper.



Check your printer setup in the Windows Control Panel.



Check that your PageKeeper transaction file is set up correctly. See Setting Up the Transaction File in 
Chapter 2 of the Owner's Manual. If the problem persists, call Technical Support.



Check that your PageKeeper transaction file is set up correctly. See Setting Up the Transaction File in 
Chapter 2 of the Owner's Manual. If the problem persists, call Technical Support.



Database files may have been deleted or corrupted. Call Technical Support.



Database files may have been deleted or corrupted. Call Technical Support.



Check that your PageKeeper transaction file is set up correctly. See Setting Up the Transaction File in 
Chapter 2 of the Owner's Manual. If the problem persists, call Technical Support.



Check that the scanner is turned on..



Report this problem to Technical Support.



Check your scanner setup. If you were able to use your scanner very recently, you may have a memory 
problem. See the instructions for the error The supply of free memory is very low.



You may be out of disk space or have a bad disk. 



If you want to annotate the file, you can import it into the database.



There was a discrepancy between the number of top and bottom pages for your double-sided scanning 
job; there may be a paper-jam in the scanner.



The external file you are trying to open does not have an application associated with it. After you create 
an association with the Associate... command in the File menu of the File Manager, PageKeeper can 
launch it.



You may have placed two blank pages in a row into the automatic document feeder. The other likely 
cause is a paper-jam in the scanner.



There is no image for this page of the document; when you import a text-only file or view an external file, 
the document will not have an image.



You may want to establish guidelines with users of the database. See Chapter 5 Network Sharing and    
Mailing, Database Security for more information.



You must be logged into this database as Admin to have full access to the commands in the Admin 
menu.



You can only paste items into one folder at a time. Click a single folder and select Paste again.



The Move command is not operational until you have selected one or more items to move.



Try to delete the note again. If this is not successful, you or the Admin user should recondition and re-
index the database at the earliest opportunity. If the problem persists, call Technical Support.



The index file names must be unique. Since the path you chose was used for the local external index, 
you must select a different path to locate or create your network external index.



The index file names must be unique. Since the path you chose was used for the network external 
index, you must select a different path to locate or create your local external index.



You cannot save a note without text in it. If you want to delete the note, select Delete Note from the 
Notes menu.



The note associated with the push-pin button on the document you have open was deleted by another 
user.



You may have a memory problem. See the instructions for the message The supply of free memory is 
very low.

Another possibility is that there is a problem with either the image file you are importing or the batched 
job you are finishing. Try importing or processing the job again. If the problem persists, call Technical 
Support.



You must have at least 1MB available on the database drive where you are trying to import or scan 
before the operation can begin. Delete some files on that drive and try again.



You must have at least 1MB available on the drive where Windows creates your TEMP variable. Type 
set at the DOS prompt of your MS-DOS window to locate your TEMP variable (and other environment 
variables). Then delete some files on that drive before scanning or importing again. 



You must have at least 1MB available on the drive where you are trying to export an image file. Delete 
some files on that drive before trying to export again. 



You may be low on space in the directory where Windows creates your TEMP variable. Type set at the 
DOS prompt of your MS-DOS window to locate your TEMP variable (and other environment variables). 
Then delete some files on that drive before trying to index again. 

Another possibility is that database files may have been deleted or corrupted. Call Technical Support.



Specify the Group by selecting the mailboxes you want included. To select a range, Shift-click or drag 
with the mouse. To select multiple non-contiguous recipients, Ctrl-click the icons. Ctrl-clicking also 
deselects mailboxes. Once you have selected the Group, you can drop the documents you want to mail 
into the Group mailbox.



Contacting Technical Support

Technical support is available if you need help. Call Caere Technical Support at 800 GO-CAERE (800-
462-2373). For the most efficient response, please have the following information on hand and be near 
your computer when you call:

· PageKeeper software serial number 

· PageKeeper software version number

· error message text 

· problem symptoms and the sequence of events leading up to the error

· DOS software version number

· Windows software version number

· computer manufacturer and model number

· list of peripheral devices (such as scanners) installed in your system

· amount of RAM in your system and the size and location of your Windows swap file (if present)

· listing of (or easy access to) your config.sys file

· listing of (or easy access to) your autoexec.bat file

· listing of (or easy access to) your win.ini file



Glossary of Terms
A

AccuPage AnyFont
Active window AnyPage
ADF ASCII
AND Operator Auto Intensity
Annotation Autoexec.bat
AnyFax Automatic Document Feeder (ADF)

B

Back up
Batch processing
Bitmapped image
Boolean search

C

Cancel button
Character window
Content pathways diagram
Cursor

D

Database Dithering
Default Document Agent Search
Dialog box Document
Directory Dpi

E

Error message External index
Execute
Extension
External file

F

Fax Folder window
File format Font
File Format
Filename

G, H

Hang
Highlight

I

Index

J, K, L, M

Memory (main) Mouse
Menu
Microprocessor
Mouse pointer



N, O

OCR
Open
Optical Character Recognition (OCR)
OR Operator

P

Page recognition Pixel
Parsing Point
Partial Page Recognition Prompt
Path name

Q, R

RAM
Read-only memory (ROM)
Read/write access

S

Swap file
System software

T

Text file
Thumbnail

U, V

Verification Window

W

Weighted Relevance Retrieval
Weighted Word Search
Window
Write permission

X, Y, Z

Zone/Zoning



Active window

The foremost window on the desktop; the window where the next action will take place. An active 
window's title bar is highlighted.



ADF

A device that allows you to scan multiple pages without having to place each page in the scanner. Some 
ADFs are built in to scanners; others are add-on products.



AND Operator

A logical operation for combining two values (false, true). It returns a true value, if, and only if, both 
values are true. 

In the case of a text search with any two words, both of the words must be present in a document for 
that document to be returned as a result for the search.



Annotation

A note or comment attached to a document that provides additional information. PageKeeper 
annotations are automatically indexed and can be searched.



AnyFax

Unique OCR technology, developed by Caere Corporation, that uses neural network technology to 
recognize fax images.



AnyFont

Unique OCR technology, developed by Caere Corporation, capable of recognizing most typed, 
proportional, and typeset fonts automatically. The first page-recognition approach to OCR, AnyFont can 
read anything that might be in a typical office, including a magazine page with a mixture of fonts, 
columns, text and graphics.



AnyPage

Dynamic auto-thresholding technology that sets scanning intensity automatically to deliver the highest 
quality image possible and uses special page-recognition techniques to improve OCR accuracy. 
AnyPage technology was developed by Caere Corporation. AccuPage was developed by Hewlett-
Packard Corporation. PageKeeper's Auto Intensity Brightness setting uses either of these technologies.



AccuPage

Dynamic auto-thresholding technology that sets scanning intensity automatically to deliver the highest 
quality image possible and uses special page-recognition techniques to improve OCR accuracy. 
AccuPage was developed by Hewlett-Packard Corporation. AnyPage technology was developed by 
Caere Corporation. PageKeeper's Auto Intensity Brightness setting uses either of these technologies.



Auto Intensity

Dynamic auto-thresholding technology that sets scanning intensity automatically to deliver the highest 
quality image possible and uses special page-recognition techniques to improve OCR accuracy. 
AnyPage technology was developed by Caere Corporation. AccuPage was developed by Hewlett-
Packard Corporation. PageKeeper's Auto Intensity Brightness setting uses either of these technologies.



ASCII

Acronym for American Standard Code for Information Interchange. A code in which the numbers from 0 
to 127 stand for text characters. ASCII code is used for representing text inside a computer and for 
transmitting text between computers or between a computer and a peripheral device.



Autoexec.bat

A file created with the DOS (disk operating system) language, maintained in the root directory of an 
IBM-compatible personal computer, which tells the CPU what resources to load upon booting the 
system.



Automatic Document Feeder (ADF)

A device that allows you to scan multiple pages without having to place each page in the scanner. Some 
ADFs are built in to scanners; others are add-on products.



Back up

To make a spare copy of a disk or of a file on a disk. Backing up your files and disks ensures that you 
won't lose information if the original is lost or damaged.



Batch processing

The process of storing transactions that can be executed as a group. In PageKeeper, you can use the 
Scan in Batch Mode option to scan or import files as a group and delay other processes and the Index 
in Batch Mode option to delay indexing.



Bitmapped image

A collection of bits (dots) in memory that represent the scanned image. The display on the screen is a 
visible bitmapped image.



Boolean search

A search performed for combinations of words. Named for George Boole, a nineteenth century English 
mathematician, who devised a form of algebra based on logical calculus. Variables have either true or 
false values and the relationships between variables is expressed logically with operators such as AND 
and OR. See also AND Operator, OR Operator.



Cancel button

A button that appears in a dialog box. Clicking it cancels the command.



Character window

A window that appears during the PageKeeper OCR process that lets you monitor the quality of the 
character recognition.



Content pathways diagram

A diagram of document thumbnails that shows the agent documents major subject areas and the 
relationship of other documents to it.



Cursor

A symbol displayed on the screen marking where the user's next action will take effect or where the next 
character typed on the keyboard will appear.



Database

The place where all PageKeeper documents are stored. Information in the database is indexed 
automatically.



Default

A preset response to a question or prompt. The default is automatically used by the computer if you 
don't supply a different response or setting.



Dialog box

A box that contains a message requesting more information from the computer user.



Directory

A pictorial, alphabetical, chronological or functional list of the contents of a volume or a disk.



Dithering

A dithering pattern is how a picture's gray areas are represented by black and white pixels. Different 
scanners offer a different choice of dithering patterns.



Document

A collection of information. The basic unit of storage in the PageKeeper database. Documents within 
PageKeeper are indexed automatically. 



Document Agent Search

PageKeeper method for using a single document to locate other documents with related information. 
When using the Document Agent Search, you select one document that contains information that you 
are interested in and PageKeeper analyzes the contents to find other documents with content overlaps. 
PageKeeper lists the results in their order of relevance to your request and displays a diagram of the 
documents organized by the major content pathways.



Dpi

Abbreviation for dots per inch. The number of dpi is the number of dots per linear inch that a printer can 
print or a screen can display.



Error message

A message displayed or printed to tell you of an error or problem in the execution of a program or in 
your communication with the system.



Execute

To perform the actions specified by a program command or sequence of commands.



Extension

In DOS-based systems, the part of the filename to the right of the period. For instance, the extension in 
the filename config.sys is sys. Extensions are generally used to differentiate between types of files.



External file

In PageKeeper, an external file is a file on your system located outside of the PageKeeper database.



External index

In PageKeeper, an external index is an index of files for local or remote drives. It is located outside of 
the database, but its contents can be searched from a database when either Local External Files or 
Network External Files is specified in a search window.



Fax

Short for facsimile machine and the document it creates. Fax machines scan a page, convert the image 
into digital data, and send the data over a phone line to another fax or computer. The receiving machine 
then recreates the fax image on paper or stores the data on disk as a fax file.



File

Any named, ordered collection of information stored on a disk. Application programs and operating 
systems on disks are examples of files. You make a file when you create text or graphics, give the 
material a name, and save it to disk. 



File format

The way data is recorded for a particular application. For example, the file format for one word 
processor may represent boldface with a <<197>> character; another word processor may represent it 
with a <<203>> character.



Filename

The name that identifies a file. The maximum character length of a file name and the rules for naming a 
file vary under different operating systems. In DOS-based systems, a filename cannot exceed 8 
characters plus a filename extension which cannot exceed 3 characters.



Folder window

The window that allows you to organize all documents in your database into folders. Documents and 
folders are arranged in alphabetical order in the hierarchy you establish.



Font

In typography, a complete set of type in one size and style of character. In computer usage, a collection 
of letters, numbers, punctuation marks, and other typographical symbols with a consistent appearance; 
the size can be changed readily.



Format

The form in which information is organized or presented. The general shape and appearance of a 
printed page, including page size, character width and spacing, line spacing, and so on.



Hang

A term indicating that the system has stopped working and must be rebooted.



Highlight

To make something visually distinct. Generally, highlighting reverses the image on screen or otherwise 
makes it stand out from the rest of the page. Highlighting is used to select an object or segment of a 
page upon which to perform an editing function such as Copy, Cut, or Paste.



Index

A listing that points to the location of information. PageKeeper automatically creates and updates an 
index of all documents and an index of all annotations in the database. In addition, you can create 
indexes of the files on your local hard drive or network directories. (See External index.) When you 
search for information, PageKeeper searches the index or indexes you specify.



Memory (main)

The part of a computers memory whose contents are directly accessible to the microprocessor; usually 
synonymous with random-access memory (RAM).



Menu

A list of choices presented by a program, from which you can select an action. In Windows, menus 
appear when you point to and press menu titles in the menu bar. Dragging through the menu and 
releasing the mouse button while a command is highlighted chooses that command.



Microprocessor

The integrated circuit chip component within the computer that directly executes instructions. 
Sometimes referred to as the CPU (Central Processing Unit) or processor.



Mouse

A small hand-held device used to control a pointer on the screen. The pointer can select items, initiate 
commands and perform other functions in the control and operation of various programs.



Mouse pointer

A small shape on the screen that follows the movement of the mouse or shows where your next action 
will take place. The pointer can take the shape of an arrow, an l-beam, an hourglass, or other graphic 
character, depending on the current state of PageKeeper's activity. In PageKeeper an arrow is the 
default mouse pointer.



OCR

Acroynm for Optical Character Recognition. Automatic transfer of printed text into a computer in editable 
form. PageKeeper's OCR uses revolutionary technology from Caere Corporation that analyzes 
individual character features rather than matching shapes.



Open

To retrieve a file from storage and load it into the computer's working memory (RAM). Files must be 
open in order to work with them.



Optical Character Recognition (OCR)

Automatic transfer of printed text into a computer in editable form. PageKeepers OCR uses 
revolutionary technology from Caere Corporation that analyzes individual character features rather than 
matching shapes.

See AnyFont.



OR Operator

A logical operation for combining Boolean values (false, true). If any one of the values is true, it returns a 
true value.

In the case of a text search with any two words, if either of the words is present in a document, that 
document is returned as a result for the search.



Page recognition

The process of turning a scanned page into text, which includes page decomposition: the separation of 
textual and graphical elements, and recognition of the text.



Parsing

The breaking down of a page into blocks of text and graphic areas.



Partial Page Recognition

The process of selecting which sections of a scanned page should be recognized and in what order.



Path name

The full name by which an operating system identifies a file. A path name is a sequence of names, each 
preceded by a slash, that specifies the path    from volume directory to file    by which the operating 
system locates a file.



Pixel

Short for picture element. A point on the graphics screen.



Point

A typographic unit of measurement equal to 1/72 inch, measured vertically.



Prompt

A message on the screen that tells you of some need for response or action. A prompt usually takes the 
form of a symbol, a message, a dialog box, or a menu of choices.



RAM

Acronym for random access memory. Memory in which information can be referred to in an arbitrary or 
random order. Generally, the work space within the computer, temporary in nature, sustained only while 
the power is on.



Read/write access

The ability to display and make changes to the designated file.



Read-only memory (ROM)

Memory whose contents can be read, but not changed. Information is placed into read-only memory 
once, during manufacture; it then remains there as part of the computer's permanent instruction set, 
even when the computer's power is turned off.



Swap file

An area of the hard disk that Windows uses for temporary data storage when RAM is low or used up.



System software

Software required for the proper operation of a computer system; it supports application programs by 
managing system resources such as memory and input/output (1/0) devices.



Text file

A file containing information in text form and whose contents are interpreted as characters encoded 
using the ASCII (or comparable) format.



Thumbnail

A miniaturized image of the actual document in the PageKeeper database.



Transaction File

This is a file that contains information that allows PageKeeper to recover from database failures.



Verification Window

A PageKeeper feature that lets you see parts of the original scanned image when you are editing a text 
file. 



Weighted Relevance Retrieval

PageKeepers method of ranking documents in a results list according to how important the search 
terms are within the document and within the database as a whole. A colored relevance bar for each 
document graphically displays the closeness of the match to your query. Highly relevant documents are 
highlighted with red, moderately relevant documents are highlighted with green, and documents that are 
somewhat relevant are highlighted in blue.



Weighted Boolean Search

PageKeeper method for locating documents with up to six search terms. When using the Weighted 
Boolean Search, you restrict your search by specifying that at least two of the words in your search (one 
on each side of the AND operator) must be in a single document. PageKeeper returns any results in 
their order of relevance to your request.



Weighted Word Search

PageKeeper method for locating documents. When using the Weighted Word Search you can type in as 
many words as you want to refine your search. PageKeeper returns the results in their order of 
relevance to your request.



Window

The area that displays a file on the screen within the Windows environment; you view the file's contents 
within a window. It is possible to have several windows open on screen at once, however, only one will 
be active at a time.



Write permission

The ability to make changes to the designated file.



Zone/Zoning

An enclosed area for text recognition of a scanned page that you can create and order with the 
PageKeeper Recognition tools. Zoning is the process of specifying the zones.



Zoning/optical character recognition (OCR)/editing

Zoning is an available option for imported image files and scanned documents. 

OCR is an automatic process for imported image files and scanned documents. 

Editing is an available option for image files, scanned documents, and text-only files from your system.




